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Aarons; Edward S. B+ 1983 N Assignment Moon Girl Not Sf
Adams; Douglas C 1989 N Dirk Gently's Holistic Detective Agency
Adams; Douglas B- 1984 N Hitchhikers Guide To The Galaxy
Adams; Douglas C- 1984 N Restaurant At The End Of Universe
Adams; Richard F 1986 N Plague Dogs Boring
Adams; Richard A 1995 Y C N Watership Downs 2 75/A+
Addison; Joseph B- 1989 N Tesseract
Agustus; Albert B 1978 Y C N Slaves Of Lomooro
Aikin; Jim X 1989 N Walk The Moons Road
Alban; Antony D+ 1981 N Cartharsis Central
Aldiss; Brian F 1986 Y N Earthworks
Aldiss; Brian D 1979 N Neanderthal Planet
Aldiss; Brian N Who Can Replace Man Don't Read
Allingham; Margary B 1989 T Case Of The Late Pig Campion-PBS
Allingham; Margary C 1990 T C34 Dancers In Mourning Campion-PBS
Allingham; Margary C+ 1989 T Death Of A Ghost Campion-PBS
Allingham; Margary C 1990 T Flowers For The Judge Campion-PBS
Allingham; Margary B 1990 T Look To The Lady Campion-PBS
Allingham; Margary B- 1990 T Mystery Mile Campion-PBS
Allingham; Margary C+ 1989 T Police At The Funeral Campion-PBS
Allingham; Margary A+ 1990 T Sweet Danger Campion-PBS
Allingham; Margary B- 1990 N C40 Traitors Purse Will Marry Amanda
Allston; Arron B N X-Wind Solo Command Star Wars Book
Anderson; Colin D 1983 N Magellan
Anderson; Poul A 1983 Y C N After Doomsday
Anderson; Poul B 1978 Y C N A2 Agent Of Terra
Anderson; Poul C 1980 Y N Avatar; The
Anderson; Poul B 1978 SN Beyond The Beyond
Anderson; Poul C+ 1983 Y C N Brain Wave
Anderson; Poul N Broken Sword
Anderson; Poul B 1980 Y C N Byworlder; The
Anderson; Poul B+ 1978 Y C N A4 Circus Of Hells
Anderson; Poul B 1982 SS P2 Cold Victory
Anderson; Poul D- 1985 SS Conflict
Anderson; Poul B+ 1978 Y N Corridors Of Time
Anderson; Poul C 1982 Y C N Dancer From Atlantis
Anderson; Poul D- 1983 N Day Of Their Return
Anderson; Poul C- 1981 N Demon Of Scattery W/ Broxon
Anderson; Poul D+ 1981 N Devils Game
Anderson; Poul A 1982 Y SS Sg2 Earth Book Of Stormgate
Anderson; Poul B+ 1985 Y SS Earthmans Burden
Anderson; Poul C 1982 N Enemy Stars
Anderson; Poul B 1978 Y N A1 Ensign Flandry
Anderson; Poul B 1977 Y C N Firetime
Anderson; Poul A 1978 Y N A5 Flandry Of Terra
Anderson; Poul C 1983 SS Gods Laughed; The
Anderson; Poul B 1979 Y C N Guardians Of Time
Anderson; Poul B+ 1981 Y N High Crusade
Anderson; Poul C- 1984 N Homeward And Beyond
Anderson; Poul B- 1979 SS Horn Of Fire
Anderson; Poul 1978 SS Horn Of Time
Anderson; Poul N Iron > Man-Kzin Wars
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Anderson; Poul C- 1986 Y C N A7 Knight Of Ghosts And Shadows
Anderson; Poul C+ 1978 Y N Let The Spacemen Beware! F209
Anderson; Poul B 1978 Y N Long Way Home
Anderson; Poul B+ 1984 Y N Makeshift Rocket F139
Anderson; Poul A- N Man-Kzin Wars > Niven
Anderson; Poul N Man Who Counts > War Wing Me
Anderson; Poul D 1982 N Mermans Children
Anderson; Poul D 1978 N Midsummers Tempest
Anderson; Poul B 1978 Y C N B6 Mirkheim
Anderson; Poul N Night Face > Let Spacemen Beware
Anderson; Poul B+ 1995 Y N Operation Chaos 2 80/A
Anderson; Poul C 1980 Y C N Orbit Unlimited
Anderson; Poul X 1988 N Orion Shall Rise Boring
Anderson; Poul C- 1986 RS Past Times
Anderson; Poul B- 1984 Y N Sg1 People Of The Wind
Anderson; Poul B 1978 Y N P4 Peregrine; The
Anderson; Poul B 1978 N Perish By The Sword Not Sf
Anderson; Poul B 1983 N Planet Of No Return Buy 
Anderson; Poul A 1984 SN P1 Psychotechnic League Buy
Anderson; Poul SS Queen Of Air And Darkness
Anderson; Poul Y N Question & Ans. > Planet Of No Return
Anderson; Poul B 1978 Y C N A3 Rebel Worlds
Anderson; Poul B+ 1978 Y C N B4 Satans World
Anderson; Poul B 2008 Y N Shield 2 83A/08B
Anderson; Poul B 1978 Y C N Star Fox
Anderson; Poul A 1980 Y N Star Prince Charlie
Anderson; Poul N Star Ways > Peregrine
Anderson; Poul C 1984 SS P3 Starship
Anderson; Poul A 1984 Y C N A6 Stone In Heaven
Anderson; Poul N Strangers From Earth
Anderson; Poul C 1980 Y N Tau Zero Old Type Book
Anderson; Poul D+ 1984 N There Will Be Time
Anderson; Poul B 1979 Y N Three Hearts & Three Lions
Anderson; Poul C+ 1980 Y C N Three Worlds To Conquer
Anderson; Poul B 1978 Y N Time & Stars
Anderson; Poul D+ 1984 N Time Patrolman
Anderson; Poul B 1978 Y SN B2 Trader To The Stars
Anderson; Poul B+ 1978 Y C N B3 Trouble Twisters
Anderson; Poul N Twilight World
Anderson; Poul B+ 1984 Y C SN Un-Man & Other S.N. F139
Anderson; Poul C 1978 N Vault Of The Ages
Anderson; Poul A 1979 Y N P5 Virgin Planet
Anderson; Poul 1978 Y N B1 War Of The Wing Men
Anderson; Poul B 1983 Y C N World Without Stars
Anthony; Piers N Battle Circle Combined Series
Anthony; Piers C+ 1987 N I2 Bearing An Hourglass
Anthony; Piers C+ 1990 N I5 Being A Green Mother
Anthony; Piers B- 1983 Y C N P2 Blue Adept
Anthony; Piers A- 1979 Y C N Z3 Castle Roogna
Anthony; Piers B- 1983 Y C N Z4 Centaur Isle
Anthony; Piers B 1982 Y C N C2 Chaining The Lady
Anthony; Piers C 1980 Y C N T1 Chthon
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Anthony; Piers C+ 1978 Y C N C1 Cluster
Anthony; Piers C 1985 Y C N Z8 Crewel Lye
Anthony; Piers B- 1984 Y C N Z7 Dragon On Pedestal
Anthony; Piers B 1988 Y C N Dg1 Dragon's Gold W/ Margoff  Fantasy
Anthony; Piers B 1991 Y N E.S.P. Worm W/ Margoff  Fantasy
Anthony; Piers N Ct3 Faith Of Tarot Don't Read
Anthony; Piers D- 1988 N Ct1 God Of Tarot
Anthony; Piers B- 1988 Y C N Z9 Golem In The Gears
Anthony; Piers D+ 1986 N Hasan
Anthony; Piers C 1991 N Z11 Heaven Cent
Anthony; Piers A- 1983 Y C N P3 Juxtaposition
Anthony; Piers C+ 1982 Y C N C3 Kirlian Quest
Anthony; Piers C+ 1983 N Macroscope
Anthony; Piers Z12 Man From Mundania
Anthony; Piers N St2 Mercenary -Space Tyrant Don't Read
Anthony; Piers C+ 1983 Y C N Mute
Anthony; Piers D 1980 N D3 Neq The Sword
Anthony; Piers C+ 1985 Y C N Z6 Night Mare
Anthony; Piers B- 1982 Y C N Z5 Ogre; Ogre
Anthony; Piers B 1978 Y C N O1 Omnivore
Anthony; Piers A- 1986 Y C N I1 On A Pale Horse
Anthony; Piers B+ 1975 Y N O2 Orn
Anthony; Piers C+ 1976 Y C N O3 Ox
Anthony; Piers D+ 1989 N P4 Out Of Phaze Series Restart
Anthony; Piers C 1980 Y C N T2 Phthor
Anthony; Piers C- 1986 N Pretender
Anthony; Piers B+ 2002 Y N Prostho Plus  2 81/B+
Anthony; Piers B+ 2005 Y N Race Against Time 2 89/B
Anthony; Piers F 1985 N St1 Refugee -Space Tyrant
Anthony; Piers C+ 1978 Y C N Rings Of Ice
Anthony; Piers P5 Robot Adept Don't Read
Anthony; Piers B- 1989 Y N Shade Of The Tree 2  Horror S.F.  89/A-
Anthony; Piers B 1979 N D1 Sos The Rope
Anthony; Piers C+ 1979 Y C N Z2 Source Of Magic
Anthony; Piers A 1992 Y C N Z1 Spell For Chameleon 2 77/A+
Anthony; Piers A- 1983 Y C N P1 Split Infinity
Anthony; Piers C+ 1988 N Steppe
Anthony; Piers A- 1983 Y N C4 Thousandstar
Anthony; Piers B+ 1981 Y C N Triple Detente
Anthony; Piers C+ 1989 N Z10 Vale Of The Vole
Anthony; Piers C 1979 N D2 Var The Stick
Anthony; Piers B- 1984 Y C N C5 Viscous Circle
Anthony; Piers N Ct2 Vision Of Tarot Don't Read
Anthony; Piers C 1989 N I4 Wielding A Red Sword
Anthony; Piers C 1987 N I3 With A Tangled Skein
Anvil; Christopher B- 1988 Y N Pandora's Planet
Anvil; Christopher C+ 1988 N Strangers In Paradise
Anvil; Christopher C+ 1989 N Warlords Planet
Armstrong; Charlotte C+ 2001 N Gift Shop Mystery
Asimov; Issac N 50 Short Tales Don't Read
Asimov; Issac Alternate Asimovs
Asimov; Issac A+ 1978 Y C SS Asimovs Mysteries
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Asimov; Issac C+ 1989 SS Azazel (Little Devil Stories)
Asimov; Issac N Before The Golden Age  Not Asimov
Asimov; Issac B+ 1978 Y SS Best Of Asimov
Asimov; Issac Best Sf Of Asimov
Asimov; Issac C 1978 SS Bicentenial Man & Others
Asimov; Issac Y SS Buy Jupiter
Asimov; Issac B- 1990 SS B1 Casebook Of The Blackwidowers
Asimov; Issac A- 1998 Y N Rn1 Caves Of Steel 2 Fh2  B+/78
Asimov; Issac Complete Robot !Combined R Series! Future History= Fh1
Asimov; Issac B+ 1998 Y N Ge1 Currents Of Space 2 Fh6   98/bB
Asimov; Issac B 1979 Y N Ls1 David Star Space Ranger
Asimov; Issac B- 1978 Y C N Death Dealers  (Whiff Of Death)
Asimov; Issac N Double Planet
Asimov; Issac B 1984 Y SS Ea1 Early Asimov Book 1
Asimov; Issac B+ 1990 Y SS Ea2 Early Asimov Book 2
Asimov; Issac Y SS Earth Is Room Enough
Asimov; Issac B- 1986 Y N End Of Eternity 2
Asimov; Issac N Fact And Fancy
Asimov; Issac B 1978 Y N Fantistic Voyage !Hard!
Asimov; Issac A+ 1977 Y N F1 Foundation Fh10  Look For F0 
Asimov; Issac B- 1990 Y N F5 Foundation & Earth Fh14
Asimov; Issac A+ 1977 Y N F2 Foundation & Empire Fh11
Asimov; Issac A 1984 Y C N F4 Foundations Edge Fh13
Asimov; Issac Y N Foundation Trilogy >separates   !Hardcover
Asimov; Issac N From Earth To Heaven
Asimov; Issac A- 1987 Y C N Gods Themselves 2
Asimov; Issac N Hugo Winners
Asimov; Issac A+ 1978 Y SS Rs1 I; Robot
Asimov; Issac N Is Anyone There
Asimov; Issac N Kite That Won Revolution
Asimov; Issac B 1979 Y N Ls5 L.S. Big Sun Mercury
Asimov; Issac B 1978 Y N Ls4 L.S. Moons Of Jupiter
Asimov; Issac B 1977 Y N Ls3 L.S. Oceans Of Venus
Asimov; Issac B 1978 Y N Ls2 L.S. Pirates Asteroids
Asimov; Issac B 1980 Y N Ls6 L.S. Rings Of Saturn
Asimov; Issac N L.S. Space Rangr > David Star ...
Asimov; Issac 1977 Y SS Martian Way & Others
Asimov; Issac B+ 1978 SS B2 More Tales Blackwidowers
Asimov; Issac B+ 1994 Y C N Murder At The ABA 2 78/B+
Asimov; Issac A+ 1998 Y N Rn2 Naked Sun 2 Fh3  78/A+
Asimov; Issac B+ 1984 Y SS Nightfall & Others
Asimov; Issac B+ 1984 Y SS Nine Tomorrows
Asimov; Issac NC 1990  SN Norby Chronicles
Asimov; Issac NC 1990 SN Norby; Robot For Hire
Asimov; Issac C 1978 N Opus 100
Asimov; Issac B+ 1998 Y N Ge3 Pebble In The Sky 2 Fh8  77/B+
Asimov; Issac 1978 Y C N Planet That Wasn't  Essays
Asimov; Issac N Planets For Man
Asimov; Issac A+ 1989 Y N F0 Prelude To Foundation Fh9
Asimov; Issac 1989 N Rc1: Odyssey (Robot City) >Kube-Mcdowell
Asimov; Issac A+ 1978 Y SS Rs2 Rest Of The Robots
Asimov; Issac B+ 1987 Y C N Rn4 Robots And Empire Fh5
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Asimov; Issac B+ 2004 Y N Rn3 Robots Of Dawn 2 Fh4   86/B+
Asimov; Issac A+ 1977 Y N F3 Second Foundation Fh12
Asimov; Issac B+ 2004 Y N Ge2 Stars Like Dust  2 Fh7   86/B-
Asimov; Issac SS B3 Tales Of Blackwidowers
Asimov; Issac B 1986 SS Thirteen Crimes Of S.F.  Not Asimov
Asimov; Issac B- Y N Whiff O Death > Death Dealer
Asimov; Issac B+ 1988 Y C SS Winds Of Change
Asprin; Robert Lynn B+ 1989 Y N M1 Another Fine Myth
Asprin; Robert Lynn B+ 1989 Y N M4 Hit Or Myth
Asprin; Robert Lynn B+ 1989 Y N M6 Little Myth Marker
Asprin; Robert Lynn C+ 1989 N Mirror Friend; Mirror Foe W/ Takei
Asprin; Robert Lynn C+ 1990 Y N M7 M.Y.T.H. Inc. Link Set Up For #8
Asprin; Robert Lynn B 1989 Y N M2 Myth Conceptions
Asprin; Robert Lynn B+ 1989 Y N M3 Myth Directions
Asprin; Robert Lynn B- 1989 Y N M5 Myth-Ing Persons
Asprin; Robert Lynn B+ 1990 Y N M8 Myth-Nomers & Impervections
Asprin; Robert Lynn Sanctuary Combined S1-S2
Asprin; Robert Lynn C- 1987 SS S3 Shadows Of Sanctuary
Asprin; Robert Lynn C 1987 SS S2 Tales From The Vulgar Unicorn
Asprin; Robert Lynn A- 1989 Y N Tambu
Asprin; Robert Lynn C- 1987 SS S1 Thieves World
Avery; Richard B 1995 Y N Ex1 Deathworms Of Kratos 2 76/B-
Avery; Richard B 1995 Y N Ex2 Rings Of Tantalus 2 76/B-
Avery; Richard B- 1995 Y N Ex4 Venom Of Argus 2 79/B-
Avery; Richard B- 1995 Y N Ex3 War Games Of Zelos 2 77/B-
Aycock; Dale X 1989 N Starspinner
Bailey; Denis R B+ C N Tin Woodman > Bishcoff
Bailey; Robin W. D+ 1991 N Frost
Ball; Brian D 1983 N P2 Planet Probability
Ball; Brian D+ 1983 N P1 Probability Man
Banister; Manly B+ 1979 N Conquest Of Earth
Barbot; Pierre D- 1989 N Games Psyborgs Play
Barnes; Steven C N D2 Barsoom Project > Niven
Barnes; Steven B N Descent Of Anasi > Niven
Barnes; Steven B N D1 Dream Park > Niven
Barnes; Steven B 2002 Y N Saturn's Race >Niven
Barr; Donald B+ 1977 Y C N Space Relations
Barrett; Neal Jr D 1984 N Gates Of Time
Barton; William D 1978 N Plague Of All Cowards
Bass; T.J. A- 1982 Y C N Godwhale
Bass; T.J. B 1983 Y C N Half Past Human
Bayley; Barrington Jr D+ 1983 N Starwinds
Beach; Edward L. C+ 1982 N Cold Is The Sea Not Sf
Bear; Greg B 2006 N Moving Mars
Benford; Gregory C+ 1990 N Heart Of The Comet W/ Brin
Bennet; Marcia J C+ 1990 N Nl3 Beyond The Drak's Teeth
Bennet; Marcia J B- 1989 N Nl2 Shadow Singer
Bennet; Marcia J Where Is Ni-Lach
Bennet; Marcia J B- 1989 N Nl1 Where The Ni-Lach
Bester; Alfred D+ 1979 N Starburst
Biggle; Loyd Jr. B+ 2002 Y N D1 All Colors Of Darkness 2 F1986 C1963  77/B+
Biggle; Loyd Jr. A 1994 Y N Angry Espers 2 D485     76/A+
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Biggle; Loyd Jr. B+ 2002 Y N D3 Darkening Universe, This      77/B- 2 F1995 C1975 oversize
Biggle; Loyd Jr. A 2002 Y N Fury Out Of Time 2 82/A+
Biggle; Loyd Jr. B+ 2004 Y SS Galaxy of Strangers oversize
Biggle; Loyd Jr. A 1994 Y C N Light That Never Was 2 79/A+
Biggle; Loyd Jr. B 1976 SS Metallic Muse
Biggle; Loyd Jr. A 2002 Y N Monument 3 86/A+
Biggle; Loyd Jr. N Rule Of Door & Other Regs.
Biggle; Loyd Jr. A+ 2002 Y N D4 Silence Is Deadly 2 C1977  hardcover   78/A+
Biggle; Loyd Jr. 1979 Y N Silent Sky
Biggle; Loyd Jr. A+ 1992 Y N B1 Still Small Voice Of Trumpets 2
Biggle; Loyd Jr. A- 2002 Y N D2 Watchers Of The Dark 2 F1988 C1966    79/A-
Biggle; Loyd Jr. A 2002 Y N D5 Whirligig Of Time 2 C1979  oversize   80/A
Biggle; Loyd Jr. B 1992 Y N B2 World Menders 2
Binder; Eando (Otto) C 1976 N Puzzle Of Space Pyramids
Bischoff; David N D1 Day Dragonstar Don't Read
Bischoff; David C+ 1986 N Gm1 Destiny Dice Gaming Magi #1
Bischoff; David A- 1983 Y C N Forbidden World
Bischoff; David B- 1987 Y N Sh2 Galactic Warriors
Bischoff; David B 1985 Y C N Sh1 Infinite Battle
Bischoff; David B+ 1987 Y N Sh3 Macrocosmic Conflict
Bischoff; David C+ 1985 N D2 Night Dragonstar
Bischoff; David A+ 1979 Y C N N1 Nightworld
Bischoff; David C 1981 N Sf1 Starfall
Bischoff; David C- 1987 N Sf2 Starspring
Bischoff; David B+ 1982 Y C N Tin Woodman W/ Bailey
Bischoff; David C- 1981 N N2 Vampires Of Nightworld
Bishop; George B- 1990 N Shuttle People Detective Story
Blish; James 3N After Such Knowledge Combined R1-R3
Blish; James C 1985 N And All Stars A Stage
Blish; James C 1979 N Beyond The Barrier
Blish; James A 1981 Y T R2a Black Easter (Faust Aleph Null) Religious Fantasy
Blish; James C 1980 N R3 Case Of Conscience
Blish; James Y C C1-4 Cities In Flight > C1; C2; C3 & C4
Blish; James N Clash Cymbals > Triumph Of Time
Blish; James C+ 1986 Y N R2b Day After Judgement Religious Fantasy
Blish; James F 1984 N R1 Doctor Mirablis Boring Historical
Blish; James D 1979 N Duplicated Man
Blish; James A- 1980 Y N C3 Earthman Come Home
Blish; James C- 1984 N Fallen Star
Blish; James N Faust Aleph Null > Black Easter
Blish; James C+ 1980 Y N Galactic Cluster
Blish; James B+ 1980 Y N Jack Of Eagles
Blish; James A 1980 Y C N C2 Life For The Stars
Blish; James B 1982 Y C SN Midsummer Century
Blish; James B 1982 Y N A2 Mission To Heart Stars
Blish; James C- 1986 N Night Shapes
Blish; James B+ 1979 Y C N Quincunx Of Time
Blish; James A+ 1980 Y C N Seedling Stars
Blish; James N Spock Must Die > Star Trek
Blish; James B+ 1980 Y N A1 Star Dwellers Teen Book
Blish; James B 1979 Y N C1 They Shall Have Stars
Blish; James A- 1979 N Titans Daughter
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Blish; James B 1979 Y N Torrent Of Faces
Blish; James B 1981 Y N C4 Triumph Of Time
Blish; James A 1984 Y N Vor
Blish; James B 1980 Y N Warriors Of Day
Blish; James N Year 2018 >They Shall Have Stars
Bonnano; Margarat C N Probe >Star Trek
Boulle; Pierre B 1977 N Planet Of Apes
Bova; Ben C- 1982 N Thx1138
Boyce; Chris D 1977 N Catchworld
Boyd; John B 1981 Y C N Andromeda Gun
Boyd; John C+ 1982 Y C N Barnards Planet
Boyd; John N Doomsday Gene
Boyd; John A+ 1978 N Girl With Jade Green Eyes
Boyd; John X 1980 N Gorgon Festival Don't Read
Boyd; John N I.Q. Merchant
Boyd; John B 1978 N Last Starship From Earth
Boyd; John B 1987 Y N Organ Bank Farm
Boyd; John B 1977 N Pollinators Of Eden
Boyd; John 1979 Y N Rakehells Of Heaven
Boyd; John C- 1981 N Sex & High Command
Brackett; Leigh C+ 1987 N Alpha Centauri Or Die
Brackett; Leigh B- 1984 Y N Nemisis From Terra F123
Brackett; Leigh B+ 1979 N Starmen Of Llyrdis
Brackett; Leigh D 1987 N Sword Of Rhiannon Old-Boring
Bradbury; Edward P. C+ 1975 Y C N Blades Of Mars
Bradbury; Ray Y C N Autumn People
Bradbury; Ray B- 1994 Y N Dandelion Wine 2 75  Classic
Bradbury; Ray D 1995 N Farenheit 451 2 75
Bradbury; Ray C 1995 SS Illustrated Man 2 75 Only part read
Bradbury; Ray 1975 Y SS Machineries Of Joy
Bradbury; Ray 1975 Y N Martian Chronicles
Bradbury; Ray 1975 Y SS R Is For Rocket
Bradbury; Ray 1975 Y SS Timeless Stories
Bradbury; Ray Y C N Tomorrow Midnight
Bradley; Marion Z A 1979 Y N D8 Bloody Sun 2040
Bradley; Marion Z A 1987 Y N Brass Dragon 2 37250  Teen Book
Bradley; Marion Z B+ 1985 Y N Colors Of Space
Bradley; Marion Z B+ 1981 Y C SS Dark Intruder F273
Bradley; Marion Z B 1979 Y C N D1 Darkover Landfall 0
Bradley; Marion Z C- 1983 Y N D0 Door Through Space 15890
Bradley; Marion Z C 2008 Y N Endless Universe > Endless Voyage
Bradley; Marion Z C 2008 Y C N Endless Voyage 80B-/08C
Bradley; Marion Z C+ 1981 Y N Falcons Of Narabedla F273
Bradley; Marion Z C 1980 Y C N D4 Forbidden Tower 2001
Bradley; Marion Z C 1988 N D2.6 Hawkmistriss D2C
Bradley; Marion Z C- 1983 Y C N D11 Heritige Of Hastur 2098
Bradley; Marion Z C- 1985 N House Between Worlds
Bradley; Marion Z B+ 2009 Y C N R1 Hunters Of Red Moon 2 80A-/09B+
Bradley; Marion Z X 1990 N Inheritor Not Sf
Bradley; Marion Z B 1983 Y N D9 Planet Savers 2060
Bradley; Marion Z A- 2009 Y C N Ruins Of Isis 2 80A-/09A-
Bradley; Marion Z B+ 1995 Y N Seven From The Stars 2 F127   75/B
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Bradley; Marion Z B+ 1983 Y C N D5 Shattered Chain 2005
Bradley; Marion Z B 1979 Y C N D3 Spell Sword 2000
Bradley; Marion Z B+ 1982 Y N D6 Star Of Danger 2025
Bradley; Marion Z D+ 1983 N D2 Storm Queen
Bradley; Marion Z C 1984 N Survey Ship
Bradley; Marion Z B+ 2009 Y C N R2 Survivors; The 2 79?/09B+
Bradley; Marion Z B 1981 Y N D10 Sword Of Aldones 2070
Bradley; Marion Z N D2.8 Two To Conquer D2E
Bradley; Marion Z D+ 1986 N Warrior Woman
Bradley; Marion Z B 1983 Y N D7 Winds Of Darkover 2030
Bradley; Marion Z B+ 1983 Y N D12 World Wreckers 2106
Brawn; Lillian C 2008 Y N Cat Who Talked Turkey (audio) mystery (sort of)
Brin; David C+ N Heart Of The Comet >Benford
Brin; David C+ 1989 N Postman
Brin; David A+ 1986 Y N Practice Effect Hard
Brin; David C+ 1987 SS River Of Time
Brin; David B- 1986 Y C N Up2 Startide Rising
Brin; David B 1986 Y N Up1 Sundiver
Brin; David B- 1988 Y N Up3 Uplift War
Brooks; Terry A 1986 N Magic Kingdom For Sale; Sold! Buy
Brooks; Terry B 1978 N Sword Of Shannara
Brown; Fredric B- 1978 N Martians Go Home Old Style
Brown; Fredric C+ 1984 N Rogue In Space
Brown, Rita Mae C+ 2003 N Cat On The Scent mystery
Brown; Rosel George C+ N Earthblood > Laumer
Broxon; Mildred D. C+ N Demon Of Scattery > Anderson
Brunner; John N Age Of Miracles > Day Of Star Cities
Brunner; John N Altar On Asconsel Buy
Brunner; John B 1984 Y C N Astronauts Must Not Land F227
Brunner; John B 1986 Y N Atlantic Abomination
Brunner; John B+ 1983 Y C N Avengers Of Carrig >Secret Agent Terra
Brunner; John C 1988 N Bedlam Planet
Brunner; John D- 1985 N Born Under Mars
Brunner; John A 1980 Y N Z1 Castaways World F242
Brunner; John C 1988 N Catch A Falling Star
Brunner; John B- 1985 Y N Conquer Chaos
Brunner; John C+ 1984 N Crucible Of Time
Brunner; John B 1985 Y C N Day Of The Star Cities
Brunner; John A- 1988 Y C N Double; Double Monster Sf
Brunner; John D+ 1985 N Dramaturges Of Mars
Brunner; John B- 1988 Y N Dreaming Earth
Brunner; John B 1984 Y N Endless Shadow F299
Brunner; John B 1985 Y N Enigma From Tantalus M115
Brunner; John B 1988 Y C SN Entry To Elsewhen
Brunner; John N From This Day Forward
Brunner; John N Give Warning To The World
Brunner; John Hundreth Millenium Orig Of Catch ... Star
Brunner; John B- 1984 Y C N Infinitive Of Go
Brunner; John B 1988 Y N Into The Slave Nebula
Brunner; John A- 1979 Y N Interstellar Empire
Brunner; John D- 1985 N Jagged Orbit
Brunner; John B 1984 Y N Listen! The Stars! F215
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Brunner; John B+ 1988 Y N Long Result
Brunner; John B+ 1995 Y C N Meeting At Infinity 2 D507   76/B+
Brunner; John More Things In Heaven >Astronauts -Not Land
Brunner; John B 1988 Y SN Now Then
Brunner; John A 1985 Y N Planet Of Your Own G592
Brunner; John D 1988 N Players At The Game Of People
Brunner; John A 1985 Y C N Z1 Polymath <Castaways World
Brunner; John C+ 1988 N Productions Of Time Minimum Sf
Brunner; John D- 1983 N Quicksand
Brunner; John A 1985 Y N Z2 Repairman Of Cyclops M115
Brunner; John C 1980 Y C N Rites Of Ohe F242
Brunner; John B+ 1983 Y C N Z0 Secret Agent Terra F133
Brunner; John B- 1985 Y C N Skynappers D457
Brunner; John C 1984 Y N Space Time Juggler F227
Brunner; John D- 1988 N Squares Of The City
Brunner; John N Stardroppers >Listen The Stars
Brunner; John N Stone That Never Came Down
Brunner; John D- 1987 N Tides Of Time Boring
Brunner; John B- 1984 Y C SS Time Jump
Brunner; John B- 1977 Y N Times Without Number
Brunner; John C+ 1988 N Timescoop
Brunner; John A- 1987 Y C N Total Eclipse
Brunner; John D- 1985 N Webs Of Everywhere
Brunner; John B+ 1988 Y N Whole Man
Brunner; John B- 1987 N World Swappers Don't Read
Brunner; John D+ 1983 N Wrong End Of Time
Bulmer; Keneth C 1995 Y N Beyond Silver Sky 2 D507   76/C
Bulmer; Keneth B- 1980 Y N Electric Sword Swallower 5595
Bulmer; Keneth C+ 1981 Y N Hunters Of Jundagai 68310
Bulmer; Keneth B+ 1983 Y C N Million Year Hunt F285
Bulmer; Keneth D+ 1984 N Outrun Doomsday
Bulmer; Keneth C 1975 Y N Secret Of Zei D331
Bulmer; Keneth C 1987 Y N Star Venturers 22600
Bulmer; Keneth C+ 1983 Y C N Wizard Of Starship Posiden F209
Bulmer; Keneth C+ 1995 Y N Wizards Of Senchuria 2 12140   75/C+
Burroughs; Edgar Rice C 1979 N T3 Beasts Of Tarzan
Burroughs; Edgar Rice C- 1987 Lost On Venus Boring; Old
Burroughs; Edgar Rice C 1979 N T2 Return Of Tarzan
Burroughs; Edgar Rice C 1979 N T4 Son Of Tarzan
Burroughs; Edgar Rice B+ 1978 N T1 Tarzan Of The Apes
Busby; F.M. N D1 Cage A Man
Busby; F.M. C+ 1982 D1-D3 Demu Trilogy
Busby; F.M. N D3 End Of The Line
Busby; F.M. N D2 Proud Enemy
Butler; Octavia E. D 1987 N P0 Clay's Ark Well Done; Unpleasent
Butler; Octavia E. B+ 2005 Y N P2 Patternmaster 2 P2c2  79A/
Butler; Octavia E. B 1987 Y N P3 Survivor P3c3
Butler; Octavia E. B+ 2005 Y N P1 Mind Of My Mind 2 P1  88/A-
Cadin; Martin C 1987 N Starbright
Callin; Grant Try
Carter; Lin C- 1978 N A2 Invisible Death
Carter; Lin C- 1978 N A1 Nemesis Of Evil
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Carter; Lin C- 1978 N A3 Volcano Ogre
Chalker; Jack L. B- 1986 Y N Sr4 Birth Of Flux & Anchor Stand Alone Prequel
Chalker; Jack L. B+ 2009 Y C N W2 Cererbus; Wolf In Fold 2 83B/09B+
Chalker; Jack L. B 2009 Y C N W3 Charon; Dragon At The Gate 2 83B-/09B
Chalker; Jack L. C+ 1988 N Sr5 Children Of Flux And Anchor
Chalker; Jack L. C- 1982 Y C N Dancers In The Afterglow
Chalker; Jack L. B 2000 N QM1 Demons at Rainbow Bridge book ends, QM doesn't
Chalker; Jack L. B+ 1985 N Dg2 Demons Of Dancing Gods
Chalker; Jack L. A 1983 Y C N Devil Will Drag You Under
Chalker; Jack L. B- 1985 N Downtiming Night Side
Chalker; Jack L. C- 1985 N Sr2 Empires Flux & Anchor  Trilogy Middle
Chalker; Jack L. B- 1980 Y C N Ws2 Exiles At Well Of Souls
Chalker; Jack L. C+ 1994 N Jungle Of Stars 2 77/B-
Chalker; Jack L. C+ 1988 N Gi1 Labyrinth Of Dreams
Chalker; Jack L. A- 2009 Y C N W1 Lilith; Snake In Grass 2 83B+/09A-
Chalker; Jack L. B- 1986 Y C N Rm1 Lords Of The Middle Dark
Chalker; Jack L. A- 1989 Y C N Rm4 Masks Of The Martyrs
Chalker; Jack L. C 1986 N Sr3 Masters Flux & Anchor Trilogy End
Chalker; Jack L. B 2009 Y C N W4 Medusa; Tiger By The Tail 2 87B/09B
Chalker; Jack L. C 1987 Y C N Messiah Choice Hard
Chalker; Jack L. A- 1983 Y C N Ws1 Midnight At The Well Of Souls
Chalker; Jack L. B- 1988 Y C N Rm2 Pirates Of The Thunder
Chalker; Jack L. B 1980 Y C N Ws3 Quest For The Well Of Souls
Chalker; Jack L. B 1982 Y C N Ws4 Return Of Nathan Brazil
Chalker; Jack L. B- 1989 N Cw2 Riders Of The Winds
Chalker; Jack L. C 1984 N Dg1 River Of Dancing Gods
Chalker; Jack L. D- 1988 N Gi2 Shadow Dancers
Chalker; Jack L. B- 1984 N Sr1 Spirits Of Flux & Anchor Trilogy Start
Chalker; Jack L. B 1982 Y C N Ws5 Twilight At The Well Of Souls
Chalker; Jack L. C- 1985 N Dg3 Vengance Of The Dancing Gods
Chalker; Jack L. B 1981 Y C N War Of Shadows
Chalker; Jack L. C+ 1990 Cw3 War Of Maelstrom
Chalker; Jack L. B 1989 Y C N Rm3 Warriors Of The Storm
Chalker; Jack L. A- 2002 Y C N Web Of The Chozen 2 81/A
Chalker; Jack L. C+ 1989 N Cw1 When The Changewinds Blow
Chandler; A. Bertram C 1985 Y C N T2 Alternate Martians M129
Chandler; A. Bertram A- 1982 Y C N Gs Alternate Orbits 13783
Chandler; A. Bertram B+ 1987 Y N Gf Anarch Lords
Chandler; A. Bertram C+ 1986 Y SS R Beyond The Galactic Rim F237
Chandler; A. Bertram B 1985 Y C N Ger Big Black Mark
Chandler; A. Bertram B+ 1985 Y C N T3 Bring Back Yesterday D519
Chandler; A. Bertram C+ 1985 Y N T1 Coils Of Time M107
Chandler; A. Bertram Commodore At Sea >Alternate Orbits
Chandler; A. Bertram B- 1985 Y C N Gr Contraband Outerspc R=Rim - - G609
Chandler; A. Bertram C 1982 Y C N Gs? Dark Dimensions S=Sonya - - 13783
Chandler; A. Bertram C 1985 Y N E1 Empress Of Outerspace M129
Chandler; A. Bertram D+ 1986 N Frontier Of The Dark
Chandler; A. Bertram B+ 1985 Y N Gr Gateway To Never 37062
Chandler; A. Bertram B 1986 Y N Ge1 Hard Way Up New Dbl
Chandler; A. Bertram C 1985 Y N Ge Inheritors E=Empire - - 37062
Chandler; A. Bertram B+ 1985 Y N Gs1 Into The Alternate Universe M107
Chandler; A. Bertram D- 1987 N Kelly Country
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Chandler; A. Bertram A 1986 Y N Ge Last Amazon
Chandler; A. Bertram C+ 1987 Y N Gp3 Matildas Stepchildren
Chandler; A. Bertram C+ 1985 Y C N E3 Nebula Alert G632
Chandler; A. Bertram D 1983 Y N R Rendezvous On A Lost World 15890
Chandler; A. Bertram B+ 1985 Y N Gr Rim Gods 72400
Chandler; A. Bertram C 1983 Y N R Rim Of Space F133
Chandler; A. Bertram C 1986 Y N Ge2 Road To The Rim New Dbl
Chandler; A. Bertram C- 1987 N Sea Beasts Not Sf
Chandler; A. Bertram A- 1986 Y N R Ship From Outside F237
Chandler; A. Bertram B+ 1985 Y N E2 Space Mercenaries M133
Chandler; A. Bertram B+ 1985 Y C N Ge Spartan Planet
Chandler; A. Bertram B+ 1986 Y C N Gp1 Star Courier P=Privateer
Chandler; A. Bertram B 1987 Y C N Gpf Star Loot
Chandler; A. Bertram B+ 1986 Y C N Gf Wild Ones F=Free Trader
Chant; Joy C- 1987 N Red Moon & Black Mountain
Chase; Robert R. B- 1987 N Game Of Fox And Lion Don't Read
Cherryh; C.J. C- 1978 N Brothers Of Earth
Cherryh; C.J. D 1979 N Hunter Of Worlds
Chilson; Robert X 1989 N As The Curtain Falls
Christopher; John B+ 1991 N No Blade Of Grass
Christie; Agatha 1989 T 4:50 From Paddington Marple -PBS
Christie; Agatha B+ 2004 Y N Cat Among The Pigions Poirot
Christie; Agatha C+ 2004 N Easy To Kill mystery
Christie; Agatha B- 2004 N Mirror Cracked Marple
Christie; Agatha 1989 T Murder At The Viccarage Marple, first -PBS
Christie; Agatha C+ 2004 N Murder of Roger Ackroyd Poirot
Christie; Agatha 1989 T Nemisis Marple, last? -PBS
Christie; Agatha 1989 T Partners In Crime Tommy/Tuppance  PBS
Christie; Agatha B- 2004 N Sleeping Murder 2 Marple  89-PBS
Clancy; Tom B+ 1987 Y N Hunt For Red October Not Sf
Clark; Aurthur C. 1975 Y N O1 2001 Space Odyssey
Clark; Aurthur C. B- 1984 Y N O2 2010 Space Odyssey 2
Clark; Aurthur C. B+ 1990 Y C N O3 2061: Odyessy three
Clark; Aurthur C. N Across Sea Of Stars
Clark; Aurthur C. Buy ? N Against Fall Of Night Original
Clark; Aurthur C. B+ 1997 Y N Childhoods End 2
Clark; Aurthur C. B+ 1994 Y N City And The Stars 2 Hard cover   76/A
Clark; Aurthur C. A 1981 Y N Deep Range
Clark; Aurthur C. Vp5 Diamond Moon >Preuss
Clark; Aurthur C. B 1978 Y N Dolphin Island
Clark; Aurthur C. A 2004 Y N Earthlight 2 81/A
Clark; Aurthur C. B 1980 Y SS Expidition To Earth
Clark; Aurthur C. A 1977 Y N Fall Of Moondust 2
Clark; Aurthur C. B 1986 Y N Fountains Of Paridise 2
Clark; Aurthur C. N From Ocean; From Stars
Clark; Aurthur C. A 1995 Y N Glide Path   (not SciFi) 2 75
Clark; Aurthur C. B+ 1986 Y C N Imperial Earth 2
Clark; Aurthur C. B+ 1995 Y C N Islands In The Sky 2 75
Clark; Aurthur C. N Lion Comare & Against Night
Clark; Aurthur C. N Lost Worlds Of 2001
Clark; Aurthur C.  Vp4 Medusa Encounter >Preuss
Clark; Aurthur C. 1975 Y SS Nine Billion Names Of God

2009-06-JTB-Books.xls          6/3/09      Page 11



2009-06-JTB-Books.xls    6/3/09    Page 12
Author Gd Yr O C T Ser X Notes

Clark; Aurthur C. 1975 Y C SS Other Side Of Sky
Clark; Aurthur C. 1975 Y SS Prelude To Mars Hard
Clark; Aurthur C. N Prelude To Space Original
Clark; Aurthur C. C 1992 N R2 Rama 2 w/ Gentry Lee
Clark; Aurthur C. Y SS Reach For Tomorrow
Clark; Aurthur C. A 2000 Y C N R1 Rendezvous With Rama 2 74/A+
Clark; Aurthur C. B 1982 Y C N Sands Of Mars
Clark; Aurthur C. B- 1987 Y C N Songs Of Didtant Earth
Clark; Aurthur C. C 1979 Y N Space Dreamers > Prelude To Space
Clark; Aurthur C. Y C SS Tales From The White Hart
Clark; Aurthur C. N Tales Of Ten Worlds
Clark; Aurthur C. Vp1; Breaking Strain (Venus Prime) >Preuss; Paul
Clark; Aurthur C. Vp2; Maelstom >Preuss
Clark; Aurthur C. Vp3; Hide & Seek >Preuss
Clark; Aurthur C. B- 1984 SS Wind From Sun
Clayton; Jo C 1989 N Lamarchos Diadem Novel
Clement; Hal B 1986 Y SS Best Of Hal Clement
Clement; Hal A- 1995 Y N Close To Critical 2 77/A+
Clement; Hal B+ 1995 Y N Cycle Of Fire 2 77/B+
Clement; Hal N From Outerspace > Needle
Clement; Hal A 2003 Y N Iceworld 2 78/A+
Clement; Hal A+ 1994 Y N G1 Mission Of Gravity 2 74/A+
Clement; Hal A- 1991 Y C SN Natives Of Space
Clement; Hal A- 1980 Y N B1 Needle
Clement; Hal A 2006 Y C N Nitrogen Fix 2 82A-/06A
Clement; Hal A- 1979 Y C N Ocean On Top  (old, interesting) 2 79B/08A-
Clement; Hal N Small Changes > Space Lash
Clement; Hal B 2004 Y SS Space Lash 2 82/B
Clement; Hal B- 1994 Y N G2 Starlight 2 78/C+
Clement; Hal B 1980 Y C N B2 Thru The Eye Of A Needle
Compton; D.G. F 1985 N Farewell Earths Bliss
Coney; Michael J C+ 1987 N Charisma
Coney; Michael J C- 1986 N Hero Of Downways
Coney; Michael J C 1985 N Miror Image
Coney; Michael J B- 1986 Y C N Rax
Coney; Michael J A 1986 Y C N Syzygy
Conklin; Groff 1976 Y SS Big Book Of S.F.
Conklin; Groff 1976 ? SS Possible Worlds S.F.
Conklin; Groff Y C SN Six Great Short Novels
Cooper; Edmund B+ 1981 Y C N Cloud Walker
Cooper; Edmund C 1982 N Far Sunset
Cooper; Edmund C- 1987 N Five To Twelve
Cooper; Edmund D- 1981 N Gender Genocide
Cooper; Edmund B 1980 Y C N Last Continent
Cooper; Edmund A- 1996 Y N Overman Culture 2 78/A
Cooper; Edmund B 1982 Y N Sea Horse In The Sky
Cooper; Edmund C 1980 N Seed Of Light
Cooper; Edmund A- 1982 Y C N Slaves Of Heaven
Cooper; Edmund B+ 1980 Y C N Tenth Planet
Cooper; Edmund A 1981 Y N Transite
Cooper; Edmund N Who Needs Men > Gender Genocide
Cooper; Susan Dark Is Rising Try
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Correy; Lee A+ 1983 Y C N Contraband Rocket D146
Correy; Lee B 1986 Y N Manna
Correy; Lee B- 1986 Y N Matter Of Metalaw
Correy; Lee B 1986 Shuttle Down Not Sf
Correy; Lee A- 1985 Y C N Space Doctor
Correy; Lee B- 1986 Star Driver Semi Sf
Coulsen; Juanita N Crisis On Cheiron
Coulsen; Juanita N Gates Of Eden
Coulsen; Juanita D+ 1986 N C2 Outward Bound
Coulsen; Juanita N Singing Stones
Coulsen; Juanita B- 1985 Y N Space Trap
Coulsen; Juanita N Star Sister
Coulsen; Juanita B+ 1983 Y N C1 Tomorrows Heritage Hard
Coulsen; Juanita N Unto The Lost Generation
Coulsen; Juanita N War Wizards
Coulsen; Juanita D 1985 N Web Of Wizardry
Cowper; Richard A+ 1979 Y C N Breakthrough
Cowper; Richard A+ 1979 Y C N Clone
Cowper; Richard B- 1981 N K2 Dream Of Kinship
Cowper; Richard A+ 1983 Y N Kuldesak
Cowper; Richard SS Out Where The Big Ships Go
Cowper; Richard B+ 1979 Y C N Phoenix
Cowper; Richard C 1982 N Profundus
Cowper; Richard C- 1981 N K1 Road To Corlay
Cowper; Richard D- 1989 N K3 Tapestry Of Time
Cowper; Richard B+ 1986 ? Timeout Of Mind Don't Read
Cowper; Richard A- 1981 Y C N Twilight Of Briarous
Craig; Phillip B 2008 Y N Murder At A Vinyard Mansion (audio) Mystery
Crichton; Micheal C+ 1974 N Andromeda Strain Minimal Sf
Crichton; Micheal B+ 1993 N Jurasic Park Minimal Sf
Crichton; Micheal C- 1988 N Terminal Man Not Sf
Cross, Amanda B- 2004 N Death In A Tenured Position mystery
Cummings; Ray C 1983 Y N Beyond The Vanishing Point Old - - D331
Cummings; Ray C- 1984 N Man Who Mastered Time Old
Cummings; Ray Y N Tama O Light Country Mint
Cummings; Ray C- 1994 Y C N Wandl The Invador D497   2x 76
Cussler, Clive C+ 2003 N Blue Gold action/spy
Cussler, Clive X 2003 N Sahara action/spy
Dain; Alex 1978 Y N Bane Of Kanthos 42800
Daley; Brian D N Starfollowers Of Coramonde
Dalmas; John B+ 1989 Y N F1 Fanglith  Semi-Teen
Dalmas; John B- 1988 N Homecoming
Dalmas; John B 2008 Y N R2 Playmasters 2 89B-08B  W/ Martin
Dalmas; John A 2009 Y N R1 Reality Matrix 2 89A/09A
Dalmas; John B+ 2008 Y N Regiment 2 98A-/08B+
Dalmas; John B- 1989 Y N F2 Return To Fanglith
Dalmas; John B- 1988 N Varkaus Conspiracy
Dalmas; John B- 1989 N Walkaway Claus
Dann; Jack D 1978 N Starhiker
David; Peter A- Imzadi                       BUY!! >Star Trek
David; Peter B N Q-in-Law >Star Trek
Daviot; Gordon >Tey; Josephine
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Decamp; L. Sprague C 1984 Y N Z2 Hand Of Zei F249
Decamp; L. Sprague C+ 1984 Y N Z1 Search For Zei F249
Delany; S.R. C 1984 Y C N Captives Of The Flame F199
Delany; S.R. N Einstein Intersection Don't Read
Delany; S.R. B- 1984 Y N Jewels Of Aptor F173
Del Ray; Lester C+ 1985 N Attack From Atlantis
Del Ray; Lester B- 1978 N Day Of Giants
Del Ray; Lester B 1985 Y N Moon Of Mutiny Junenile
Del Ray; Lester B 1978 N Nerves
Del Ray; Lester F 1982 N Prefered Risk > Pohl
Del Ray; Lester C- 1978 N Pstalemate
Del Ray; Lester N Risk Prefered > Prefered Risk
Derleth; August 1976 Y SS Worlds Of Tomorrow
Dexter; Colin C- 1988 T IM Dead Of Jerico Inspector Morse - PBS
Dexter; Colin D 1988 T IM Service Of All The Dead PBS-Tv
Dexter; Colin B 1988 T IM Silent World Of Nicholas Quinn PBS-Tv
Diamond; Graham D 1988 N Thief Of Kalimar
Dick; Phillip C 1987 N Crack In Space
Dick; Phillip D+ 1980 N Martian Time Slip
Dick; Phillip C+ 1984 Y SS Variable Man
Dick; Phillip B 1985 Y C N Vulcans Hammer D457
Dickson; Gordon R. A- 1988 Y N Alien Art
Dickson; Gordon R. N Alien From Arcturus > Arcturus Landing
Dickson; Gordon R. B- 1984 SS Ancient My Enemy
Dickson; Gordon R. C+ 1980 N Arcturus Landing
Dickson; Gordon R. C 1985 Y N Delusion World F119
Dickson; Gordon R. A 1981 Y C N D Dorsai Long Genetic General
Dickson; Gordon R. A- 1987 Y N Dragon And The George Hard
Dickson; Gordon R. B+ N Earthmans Burden > Anderson
Dickson; Gordon R. SS Forward
Dickson; Gordon R. A 1981 Y C N D Genetic General D449
Dickson; Gordon R. SS Guided Tour
Dickson; Gordon R. C- 1987 N Hour Of The Horde
Dickson; Gordon R. C 1981 SS Love Not Human
Dickson; Gordon R. SS Man From Earth
Dickson; Gordon R. A 1987 Y N Masters Of Everon
Dickson; Gordon R. SS Mind Span
Dickson; Gordon R. C- 1980 N Mission To Universe
Dickson; Gordon R. F 1982 N Naked To The Stars
Dickson; Gordon R. C- 1985 N D1 Necromancer
Dickson; Gordon R. No Room For Man > Necromancer
Dickson; Gordon R. B 1985 Y N None But Man
Dickson; Gordon R. B 1987 Y N On The Run
Dickson; Gordon R. C+ 1989 N Pro
Dickson; Gordon R. A 1981 Y C N R-Master
Dickson; Gordon R. B- 1980 Y C N Sleepwalkers World
Dickson; Gordon R. D+ 1985 N D2 Soldier Ask Not
Dickson; Gordon R. B- 1988 Y N Space Swimmers
Dickson; Gordon R. C+ 1988 N Spacepaw
Dickson; Gordon R. B- 1985 Y C N Spacial Delivery F119
Dickson; Gordon R. A- 1985 Y N D Spirit Of Dorsai
Dickson; Gordon R. SS Stranger
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Dickson; Gordon R. B- 1981 Y N D Tactics Of Mistake
Dickson; Gordon R. B- 1987 Y N Time Storm Hard
Dickson; Gordon R. C+ 1984 Y N Time To Teleport D449
Dickson; Gordon R. A- 1989 Y N Wolfling
Dillard; JM B- N Final Frontier > Star Trek 5
Dillard; JM C 2006 N trek Lost Years, The ST:TOS
Dillard; JM C+ N Undiscovered Country > Star Trek 6
Disch; Thomas D 1981 N Genocides
Donaldson; Stephen R F 1986 #1 Lords Foul Bane Boring
Doyl; Sir Arthur Conan 1981 N Marcot Deep Dated
Dozois; Gardner B 1981 Y C N Nightmare Blue
Dozois; Gardner F+ 1988 N Strangers
Drake; David F 1985 N Forlorn Hope
Duane; Diane C 1979 N Door Into Fire
Duncan; David A 1995 Y C N Beyond Eden 2 76/B
Duncan; David B 1983 Y N Dark Dominion
Duncan; David C 1979 N Door Into Fire
Dvorkin; David A- 1983 Y C N Children Of Shiney Mountain
Dvorkin; David C- 1985 N Green God
Edmondson; G.C. B 1977 N Aluminum Man
Edmondson; G.C. D 1987 N Blue Face
Edmondson; G.C. C+ 1988 N Man Who Corupted Earth
Edmondson; G.C. C+ 1977 N T.H.E.M.
Edwards; Norman A- 1987 Y N Invasion From 2500
Effinger; George Alec B N Nightmare Blue > Dozois
Eklund; Gordon C+ 1978 N Grayspace Beast
Eklund; Gordon D 1983 N Inheritors Of Earth
Elgin; Suzette Haden C 1983 Y N Comunipaths 11560
Ellison; Harlan B- 1983 Y N Man With Nine Lives D413
Ellison; Harlan 1983 Y N Touch Of Infinity D413
Emshwiller; Peter F 1994 N Short Blade
Evans; Everett E. B- 1986 Y N Man Of Many Minds 2 Teen 
Falk; Lee C- 1981 Y C N P2 Slave Market Of Mucar
Farcia; Marie C C+ 1978 N E2 Complex Man
Farcia; Marie C B+ 1978 N E1 Earth
Farmer; Philip Jose B 1980 Y C N Alley God
Farmer; Philip Jose B- 1985 N Barnstormer In Oz
Farmer; Philip Jose C 1977 N T4 Behind The Walls Of Terra
Farmer; Philip Jose C- 1980 Y C N Cache From Outer Space F165
Farmer; Philip Jose C 1980 Y N Celestial Blueprint F165
Farmer; Philip Jose B+ 1980 Y C N Dare
Farmer; Philip Jose C 1978 N R3 Dark Design
Farmer; Philip Jose B- 1981 Y C N Dark Is The Sun
Farmer; Philip Jose D 1977 N R2 Fabulous Riverboat
Farmer; Philip Jose C 1984 N Father To The Stars
Farmer; Philip Jose F 1981 N Feast Unknown
Farmer; Philip Jose D- 1981 N Flesh
Farmer; Philip Jose C- 1981 Y C N Gate Of Time
Farmer; Philip Jose B- 1980 Y C N T2 Gates Of Creation
Farmer; Philip Jose B+ 1979 N Green Odyssey
Farmer; Philip Jose D 1978 Y C N Haden Of Ancient Opar
Farmer; Philip Jose D+ 1978 N Ironcastle
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Farmer; Philip Jose C+ 1982 Y C N Jesus On Mars
Farmer; Philip Jose C 1983 Y C N T5 Lavalite World
Farmer; Philip Jose B 1977 Y N Lord Tyger X Rated
Farmer; Philip Jose D- 1986 N N Mad Goblin Db
Farmer; Philip Jose D+ 1982 N R4 Magic Labyrinth
Farmer; Philip Jose A 1980 Y C N T1 Maker Of Universe
Farmer; Philip Jose D- 1977 N Night Of Light
Farmer; Philip Jose Y C N Other Log Phileas Fogg
Farmer; Philip Jose C- 1980 Y C N T3 Private Cosmos
Farmer; Philip Jose C+ 1977 Y N Stone God Awakens
Farmer; Philip Jose B 1977 Y N Times Last Gift
Farmer; Philip Jose C 1981 N Timestop!
Farmer; Philip Jose B 1977 N R1 To Your Scattered Bodys Go
Farmer; Philip Jose B 1978 Y C N Tongues Of The Moon
Farmer; Philip Jose C- 1977 N Traitor To The Living
Farmer; Philip Jose N Two Hawks From Earth > Gate Of Time
Farren; Mike F 1990 N Citizen Phaid
Federbush; Arnold D+ 1983 N Ice!
Felice; Cynthia B- 1988 N Eclipses  Barely Sf
Felice; Cynthia C+ 1989 N Godsfire
Felice; Cynthia B+ 2003 Y C N Water Witch 2 W/ Willis    89/A-
Follet; D 1988 N Eye Of The Needle  Movie -  Violent
Forward; Robert L. A 1984 Y C N D1 Dragons Egg
Forward; Robert L. A 1985 Y N Flight Of The Dragonfly
Forward; Robert L. B 2003 N Rocheworld (long version of Dragonfly)
Forward; Robert L. A 1986 Y C N D2 Starquake
Foster; Alan Dean C 1980 Y C N Black Hole
Foster; Alan Dean B 2003 Y N F6 Bloodhype                             (88 B-) 3 Flinx age=22; Minor Char
Foster; Alan Dean B+ 2001 Y C N Cachalot 2 82A/01B+
Foster; Alan Dean B 1980 N Darkstar
Foster; Alan Dean B- 2005 Y C N Ss3 Day Of Dissonance 2 85/B
Foster; Alan Dean B 2001 Y C N I3 Deluge Drivers 3 85/B- 89/B 01/B
Foster; Alan Dean B- 2003 Y C N F4 End Of The Matter 3 Flinx age=18 (or 17) 88/C+
Foster; Alan Dean B 2003 Y C N F5 Flinx In Flux 2 Flinx age=19/20
Foster; Alan Dean A 2003 Y N F1 For Love Of Mother Not        (88/B+) 3 Flinx age=(5, 15) or (8, 16)
Foster; Alan Dean C+ 1988 N Glory Lane
Foster; Alan Dean B+ 2005 Y C N Ss2 Hour Of The Gate 2 85/B
Foster; Alan Dean B+ 2001 Y C N I Inside 2 84/A
Foster; Alan Dean A 1994 Y C N I1 Ice Rigger 2 75/A
Foster; Alan Dean C+ 1985 N Krull
Foster; Alan Dean N Luana
Foster; Alan Dean B- 2001 N Man Who Used Universe 2 85/B
Foster; Alan Dean A- 1986 Y C N Midworld 2
Foster; Alan Dean B 1994 Y C N I2 Mission To Moulakin 2 79/B-
Foster; Alan Dean B- 2005 Y N Ss4 Moment Of The Magician 2 87/B
Foster; Alan Dean A- 2003 Y C N Nor Crystal Tears 2 83/A
Foster; Alan Dean B+ 2003 Y C N F3 Orphan Star 3 Flinx age=17  83/B
Foster; Alan Dean B- 1982 N Outland
Foster; Alan Dean C- 2006 Y C N Ss5 Paths Of The Perambulator 2 86/C+
Foster; Alan Dean B+ 2002 Y N Quozl 2 89/B+
Foster; Alan Dean A 2001 Y C N Sentenced To Prism 2 86/A
Foster; Alan Dean A 1999 Y C N Shadowkeep 2 86/A

2009-06-JTB-Books.xls          6/3/09      Page 16



2009-06-JTB-Books.xls    6/3/09    Page 17
Author Gd Yr O C T Ser X Notes

Foster; Alan Dean B+ 1985 N Slipt Don't Read
Foster; Alan Dean B+ 2004 Y C N Ss1 Spellsinger 2 84B/04B+
Foster; Alan Dean C N Splinter In Minds Eye > Star Wars
Foster; Alan Dean B 1976 Y C N Star Trek Log 1-9 > Star Trek
Foster; Alan Dean A- 2003 Y N F2 Tar-Aiym-Krang 3 Flinx age=16   88/B+
Foster; Alan Dean B+ 2008 Y N Ss6 Time Of Transferance 2 89B-/08B+
Foster; Alan Dean C+ 1989 N To The Vanishing Point
Foster; Alan Dean B 1999 Y C N Voyage To City Of Dead 2 84/B-
Foster; M.A. B- 1980 Y C N L1 Day Of The Klesh
Foster; M.A. Gameplayers Of Zan
Foster; M.A. D+ 1988 N Morphodite
Foster; M.A. B- 1991 N Transformer
Foster; M.A. A- 1986 Y C N L3 Warriors Of Dawn
Fox; Gardener F. B- 1984 Y C N Arsenal Of Miracles F299
Fox; Gardener F. C- 1987 N Kothar Of The Magic Sword
Frank; Pat A+ 1979 Y N Alas Babylon
Franson; Robert W. C+ 1989 N Shadow Of The Ship
Friedman; Michael Jan B- N Legacy > Star Trek
Gardner; Earl Stanley B 2000 N PM Mischevious Doll Perry Mason novel
Garner; Alan D+ 1979 N Moon Of Gomrath
Garnet; Dave D 1987 N Starseekers
Garret; Randal G3 Bronze Of Edarta
Garret; Randal RS Murder and Magic
Garret; Randal B- 1990 G2 Glass Of Dyskornis
Garret; Randal B+ 1989 Y N G1 Steel Of Raithskar W/ Heydron
Garret; Randal B 1977 N Unwise Child
Garson; Paul D 1977 N Great Quill
Gaskel; Jane D 1984 N Serpent; The
Gernsback; Hugo C 1983 Y N Ralph 124c 41+ Old; 1911; Good
Gerrold; David B+ 1979 N Deathbeast
Gerrold; David A+ N Flying Sorcerers 2 > Niven 
Gerrold; David B 1979 Y C N Man Who Folded Himself
Gerrold; David D 1979 Y C N Moon Star Odyssey
Geston; Mark C- 1977 N Siege Of Wonder
Gilliland; Alexis A B 1984 Y C N End Of The Empire
Gilliland; Alexis A C+ 1984 N R2 Long Shot F Rosinante
Gilliland; Alexis A B+ 1984 N R3 Pirates Of Rosinante
Gilliland; Alexis A B- 1985 N R1 Revolution F Rosinante
Glasby; John A 1981 Y N Project Jove 68310
Glut; D.F. C- N Empire Strikes Back > Star Wars
Golden; Christie B+ N Seven Of Nine Star Trek Book
Gordon; Donald B+ 1977 N Flight Of The Bat
Gordon; Rex C+ 1981 Y N Utopia Minus X
Gordon; Stuart F- 1985 N One-Eye
Goulart; Ron D 1977 N Gadget Man
Goulart; Ron C- 1977 N Hawkshaw
Goulart; Ron C+ 1977 N Hellhound Project
Goulart; Ron C 1980 Y C N Plunder
Goulart; Ron C 1980 Y C N Talent For The Invisible
Graff; L.A. B- N Death Count >Star Trek
Greene; Joseph B- 1989 Y C RS Conscience Interplanetary
Greene; Joseph B 1983 Y C N Forgotten Star Hardcover   Juv.
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Greene; Joseph N Gold The Man >Mind Behind The Eye
Greene; Joseph C+ 1988 Y C N Loafers Of Refuge
Greene; Joseph B- 1987 Y N Mind Behind The Eye
Greene; Joseph B- 1987 N Star Probe
Green; Roland B- N Clan & Crown > Pournelle
Green; Roland B- 1985 N Pc1 Peace Company
Green; Roland C- N Storms Of Victory > Pournelle
Green; Roland C 1988 N Pc2 These Green Foreign Hills
Green; Roland X 1989 N Wandor's Ride
Greenleaf; William B+ 1987 Y N S2 Pandora Stone
Greenleaf; William B+ 1987 Y N S1 Tartarous Incident
Greenleaf; William C 1989 N Time Jumper
Grinnel; David C+ 1983 Y N Edge Of Time
Grinnel; David C+ 1983 Y N To Venus! To Venus! 81610
Gunn; James E N Starbridge >Williamson Jack
Gunn; James E F 1984 Y N This Fortress World D223
Haiblum; Isidore F 1978 N Wilk Are Among Us
Haining; Peter A 1989 R Dw1 Dr Who; A Celebration Interest; Good Story Lines
Haining; Peter C 1989 R Dw2 Dr Who; The Key To Time Diary Of DW Events In GB
Haining; Peter Dw Dr Who; The Time Travelers Guide
Haining; Peter C 1989 R Dw5 Dr Who; 25 Glorius Years Repetive; Good Lost Stries
Haining; Peter B 1989 R Dw3 Dr Who; The Who Files Interviews, Arrival time Chrt
Haldeman; Joe F 1983 N All My Sins Remembered
Hambly; Barbara D N Children of the Jedi Star Wars Book
Hambly; Barbara A+ Y C N Ishmael > Star Trek
Hambly; Barbara C 1991 N LM1 Ladies Of Mandrigyn
Hambly; Barbara C 1991 N DM1 Silent Tower
Hambly; Barbara C 1991 N DM2 Silicone Mage
Hambly; Barbara A- 1989 Y C N Those Who Hunt The Night
Hambly; Barbara D 2000 N Witches of Wenshar
Hamilton; Edmond 1982 Y C N Outlaws Of The Moon Old
Hamilton; Edmond C+ 1982 Y N Yank At Valhalla Old - - 93900
Harrison; Harry C 1980 Y C N Bill; Galactic Hero
Harrison; Harry B+ 1982 Y C N Captive Universe
Harrison; Harry C+ 1982 Y N Daleth Effect
Harrison; Harry B- 1979 Y N Deathworld 1-3 Hard Set
Harrison; Harry C+ 1982 Y C N W1 Homeworld
Harrison; Harry B 1985 N Jupiter Plague
Harrison; Harry N Jupiter Legacy > Jupiter Plague
Harrison; Harry C 1983 N Lifeship
Harrison; Harry C- 1977 N Make Room (Soylent Green)
Harrison; Harry C 1978 N Montezumas Revenge
Harrison; Harry N Plague From Space > Jupiter Plague
Harrison; Harry B+ 1983 Y C N Planet Of No Return
Harrison; Harry A+ 1981 Y N Planet Of The Damned
Harrison; Harry C 1978 N Queen Victorias Revenge
Harrison; Harry N Soylent Green > Make Room
Harrison; Harry B- 1984 Y C N Ss5 S.S. Rat For President
Harrison; Harry B+ 1976 Y C N Ss3 S.S. Rat Saves World
Harrison; Harry B- 1982 Y C N Ss4 S.S. Rat Wants You
Harrison; Harry B+ 1981 Y C N Ss2 S.S. Rats Revenge
Harrison; Harry B 1978 N Skyfall
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Harrison; Harry B- 1982 Y C N Ss1 Stainless Steel Rat
Harrison; Harry C 1977 N Star Smashers Galaxy Rangr
Harrison; Harry C+ 1985 Y C N W3 Starworld
Harrison; Harry N Stonehenge
Harrison; Harry B+ 1986 Y C N Technicolor Time Machine 2
Harrison; Harry 1975 N Transatlantic Tunnel
Harrison; Harry B+ 1985 Y C N W2 Wheelworld
Harrison; M. John C 1977 Y N Pastel City
Heinlein; Robert A A- 2009 Y SN Assignment In Eternity 2 79/A-
Heinlein; Robert A B+ 1996 Y N Between Planets 2 78/B+
Heinlein; Robert A B 1996 Y N Beyond This Horizon 2 81/B+
Heinlein; Robert A B+ 2009 Y N LL'85 Cat Who Walks Thru Walls (4 of 5) 2 87C/09B+
Heinlein; Robert A A 2006 Y N Citizen Of The Galaxy 3 77A+/06A
Heinlein; Robert A A- 2004 Y N Day After Tomorrow 3 86/A-
Heinlein; Robert A Destination Moon
Heinlein; Robert A A+ 1994 Y N Door Into Summer 2 77/A+
Heinlein; Robert A B+ 1992 Y N Double Star 2
Heinlein; Robert A FH4 Eclipse Never Written
Heinlein; Robert A C+ 2003 Y SS Expanded Universe
Heinlein; Robert A B 1995 Y N Farmer In The Sky 2 76/B+
Heinlein; Robert A A+ 1974 Y C N Farnhams Freehold
Heinlein; Robert A A- 2002 Y C N Friday! 2 84/A
Heinlein; Robert A A- 1991 Y N Glory Road 3
Heinlein; Robert A A 1994 Y SS FH2 Green Hills Of Earth 2 77/A
Heinlein; Robert A A- 1989 Y N Have Space Suit Will Travel 3
Heinlein; Robert A C 2007 Y C N Job; A Comedy Of Justice 2 87B-/07C
Heinlein; Robert A C- 1977 Y N I Will Fear No Evil
Heinlein; Robert A B+ 1989 Y SS FH1 Man Who Sold The Moon 2
Heinlein; Robert A A+ 2009 Y N LL'58 Methusalahs Children (1 of 5) 2 76A+/09A+
Heinlein; Robert A B+ 2001 Y SS Menace From Earth 2 77/A
Heinlein; Robert A A+ 1991 Y N Moon Is A Harsh Mistress 3 67,76,91
Heinlein; Robert A B+ 2009 Y C N LL'80 Number Of The Beast  (3 of 5) 2 81B-/09B+(Oversize)
Heinlein; Robert A A- 1995 Y N Orphans Of The Sky 2 77/A
Heinlein; Robert A B+ 1977 N Past Thru Tomorrow
Heinlein; Robert A A- 2004 Y SS Pied Piper & Beyond Doubt
Heinlein; Robert A B+ 1994 Y N Podkayn Of Mars 2 77/B+
Heinlein; Robert A B+ 1995 Y N Puppet Masters 2 77/B+
Heinlein; Robert A B+ 1992 Y N Red Planet 2 76/B+
Heinlein; Robert A B- 1995 Y N FH6 Revolt In 2100 2 76/C
Heinlein; Robert A B+ 2007 Y N Rocket Ship Galileo  (old but good) 3 80B+  slow in middle
Heinlein; Robert A B+ 1992 Y N Rolling Stones 2 76/B+
Heinlein; Robert A B 1977 Y SN Six By Heinlein Orig. Of Unpleasant…
Heinlein; Robert A N Sixth Column Orig. Of Day After
Heinlein; Robert A N Sound of His Wings Never Written
Heinlein; Robert A B+ 1992 Y N Space Cadet 2 76/B+
Heinlein; Robert A B+ 1995 Y N Star Beast 2 77/B+
Heinlein; Robert A B+ 1996 Y N Starman Jones 2 77/B+
Heinlein; Robert A B 1999 Y N Starship Troupers 2 77/A
Heinlein; Robert A A- 1976 Y N Stranger In A Strange Land
Heinlein; Robert A N Stone Pillow Never Written
Heinlein; Robert A B 2009 Y N LL'73 Time Enough For Love  (2 of 5) 2 76A-/09B
Heinlein; Robert A B 1992 Y N Time For The Stars 2 77/B
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Heinlein; Robert A D+ 1988 N LL'87 To Sail Beyond The Sunset (5 of 5)
Heinlein; Robert A B+ 1977 Y N Tunnel In The Sky
Heinlein; Robert A SN Unpleasent Prof. Of J. Hoag > Six By Heinlein
Heinlein; Robert A A+ 1977 Y N Waldo & Magic Inc
Heinlein; Robert A C 1986 SS Worlds Of R.A. Heinlein 2
Herbert; Frank D 1986 D6 Chapterhouse
Herbert; Frank C+ 1978 N D3 Children Of Dune
Herbert; Frank D 1977 N Destination Void
Herbert; Frank A 1975 Y N D1 Dune
Herbert; Frank B- 1975 N D2 Dune Messiah
Herbert; Frank C- 1983 N D4 God Emperor Of Dune
Herbert; Frank C- 1977 N Heaven Makers
Herbert; Frank B+ 1980 Y N Hellstroms Hive
Herbert; Frank C+ 1984 N D5 Heratics Of Dune
Herbert; Frank B 1977 Y N Under Pressure
Herbert; Frank C- 1977 N Whipping Star
Heydron; Vicki Ann G3 Bronze Of Edarta
Heydron; Vicki Ann G2 Glass Of Dyskarnis
Heydron; Vicki Ann B+ N G1 Steel Of Rathskar >Garret
Higgens, Jack F 2004 N Keys of Hell mystery
High; Philip E B- 1984 Y N Mad Metropolis M135
High; Philip E B- 1988 Y N Prodigal Sun
High; Philip E B- 1985 Y N Reality Forbidden G609
High; Philip E A- 1987 Y C! N Twin Planets
Hillerman; Tony A 2005 N Hunting Badger detective mystery
Hillerman; Tony B- 2005 N People of Darkness detective mystery
Hillerman; Tony A 2005 N Sinister Pig (chapter skipped) detective mystery
Hillerman; Tony B 2009 N Skeleton Man (audiobook) detective mystery
Hillerman; Tony B 2005 N Skinwalker detective mystery
Hillerman; Tony A- 2005  N Wailing Wind detective mystery
Hodder-Williams D 1978 N Egg Shapped Thing
Hogan; James P B+ 1984 Y C N Code Of The Lifemaker
Hogan; James P Cn 1989 N Endgame Enigma
Hogan; James P B+ 1981 Y C N Genis Machine
Hogan; James P C 1979 N A2 Gentle Giants Granymede
Hogan; James P C 1984 N A3 Giants Star
Hogan; James P B 1979 Y C N A1 Inherit The Stars
Hogan; James P C 2004 Y C N Thrice Upon A Time 2 82/B+
Hogan; James P A 1992 Y C N Two Faces Of Tomorrow 2
Hogan; James P B+ 1983 Y C N Voyage From Yesteryear
Holly; Joan Hunter B+ 1981 Y N Dark Planet
Holly; Joan Hunter A- 1981 Y N Death Dolls Of Lyra
Holly; Joan Hunter F- 1986 N Encounter
Holly; Joan Hunter D+ 1986 N Flying Eyes
Holly; Joan Hunter B- 1987 Y N Green Planet
Holly; Joan Hunter A+ 1986 Y C N Keeper
Holly; Joan Hunter A 1983 Y N Mind Traders
Holly; Joan Hunter A- 1986 Y C N Running Man
Holly; Joan Hunter C+ 1981 Y N Time Twisters
Hooker; Richard C+ 1978 N Mash Goes To Maine Not Sf
Hoover; H.M. C+ 1989 N Delikon
Hoover; H.M. A- 1989 Y N Lost Star Teen
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Hoover; H.M. A+ 1988 Y N Rains Of Eridan
Hoover; H.M. A 1989 Y N Return To Earth
Hoskins; Robert B 1977 Y C N Control The Stars
Hoskins; Robert B 1980 Y C N Escape The Stars
Hoskins; Robert B 1977 N Shattered People
Hoyle; Fred/Geoffrey B+ 1986 Y N A1 A For Andromeda 2 W/ John Elliot
Hoyle; Fred/Geoffrey B- 1986 Y N A2 Andromeda Breakthru 2 Hardcover
Hoyle; Fred/Geoffrey B+ 1995 Y N Black Cloud 2 76/B+
Hoyle; Fred/Geoffrey C- 1986 SS Element 79 2
Hoyle; Fred/Geoffrey 1976 Y C N Fifth Planet
Hoyle; Fred/Geoffrey 1978 N Incandescant Ones
Hoyle; Fred/Geoffrey A- 1982 Y N Inferno hardcover
Hoyle; Fred/Geoffrey D- 1982 N Into Deepest Space
Hoyle; Fred/Geoffrey B+ 1982 Y N Molecule Men hardcover
Hoyle; Fred/Geoffrey B+ 1994 Y N October 1st Is Too Late 2 94/B+
Hoyle; Fred/Geoffrey A 1982 Y N Ossians Ride
Hoyle; Fred/Geoffrey C+ 1979 Y N Rockets In Ursa Major
Hoyle; Fred/Geoffrey B+ 1982 Y N Seven Steps To The Sun
Hughart; Barry D+ 1989 N Story Of The Stone
Hughes; Robert Dan C 1991 N P1 Prophet of Lamath
Hughes; Zack C+ 1983 Y C N Seed Of The Gods
Iles; Francis C 1987 T Malice Aforethought PBS-Tv Mystery
Ing; Dean N Cathouse > Man-Kzin Wars
Ing; Dean A- N Man-Kzin Wars > Niven
Jakes; John C+ 1977 N Tonight We Steal The Stars
Jakes; John F 1979 N When Star Kings Die
James; P.D. C 1986 T Cover Her Face PBS-Tv Mystery
James; P.D. C 1987 T Shroud For A Nightengale PBS-Tv Mystery
James; P.D. B- 1987 N Death Of An Expert Witness Not Sf
Janifer; Laurence M Y N High Hex 72400
Janifer; Laurence M D+ 1981 Y N Target Terra H91
Janifer; Laurence M D- 1977 N Wagered World
Javor; F.A. B+ 1981 Y C N Rim World Legacy
Jenkins; Will F. > Leinster; M.
Jeppson; J.O. D- 1986 N Second Experiment 2
Jones; D.F. D 1983 N Inplosion
Judd; Cyril B- 1983 Y N Gunner Cade D227
Judd; Cyril C+ 1988 N Outpost Mars Old
Kagen; Janet A+ Y C N Uhuras Song > Star Trek
Kahn; James A N Return Of Jedi > Star Wars
Kapp; Colin B 1998 Y C N Chaos Weapon ?98 or 78?
Kapp; Colin B+ 1999 Y C N Ion War 2 78/A
Kapp; Colin C+ 1984 N Cw2 Lost Worlds Of Cronus
Kapp; Colin B 2002  N Patters Of Chaos 2 81/B+
Kapp; Colin C+ 1984 N Cw1 Search For The Sun
Kapp; Colin C+ 1988 N Cw4 Star Search
Kapp; Colin A+ 1995 Y C N Survival Game 2 77/A+
Kapp; Colin D+ 1985 N Transfinite Man
Kapp; Colin C+ 1988 N Cw3 Tyrant Of Hades
Kapp; Colin A- 2003 Y C N Wizard Of Anharitte 2 81/A
Kelleam; Joseph C 1984 Db Overlords From Space
Kelleam; Joseph B- 1978 N When The Red King Woke
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Kelley; Leo P D 1977 N Mythmaster
Kenrick; Tony A+ 1982 N 81st Site Not Sf
Key; Alexander C+ 1988 N Case Of The Vanishing Boy Juvenile
Key; Alexander B 1988 N Escape To Witch Mountain Juvenile
Key; Alexander C+ 1989 N Flight To The Lonesome Place Juvenile
Key; Alexander A 1988 N Forgotten Door Juvenile
Key; Alexander A+ 1989 N Jagger Juvenile -Fast
Key; Alexander B- 1988 N Mystery Of The Sasafras Chair Juvenile
Key; Alexander C+ 1988 N Return Form Witch Mountain Juvenile
Key; Alexander X 1989 N Sprockets Childrens
Key; Alexander C+ 1989 N Sword Of Aradel
Kilian; Crawford B- 1985 Y C N Brother Jonathan
Kilian; Crawford B- 1984 Y C N Cp Empire Of Time Violent
Kilian; Crawford X 1989 N Eyas Boring
Kilian; Crawford C+ 1989 N Cp Fall Of The Republic Violent
Kilian; Crawford B+ 1982 N Icequake Semi Sf
Kilian; Crawford B 1988 Y N Lifter Juvenile
Killough; Lee C- 1984 SS Aventine
Killough; Lee A- 2004 Y C N Jb3 Deadly Silents 2 84/A-
Killough; Lee B+ 2004 Y C N Jb1 Dopplerganger Gambit 2 84/B+
Killough; Lee X 1989 N Leopard's Daughter Boring
Killough; Lee A- 2003 Y C N Liberty's World 2 86/B-
Killough; Lee A 2004 Y C N Moniter; Miners & Shree 2 84/B+
Killough; Lee B- 2001 Y N Jb2 Spider Play 2 87/B-
Killough; Lee Voice Out Of Ramah
King; Stephen C+ 1989 N Eyes Of The Dragon
King; Stephen C- 1983 N Stand
Kippax; John D N Neutral Stars > Morgan; Dan
Klein; Gerard D 1986 N Overlords Of War
Klein; Gerard F 1986 N Starmasters Gambit
Knight; Damon B- 1975 N A For Anything Bad Beg. And End
Knight; Damon B+ 1987 Y N Beyond The Barrier Hard
Knight; Damon B+ 1981 Y N Hells Pavement
Knight; Damon B 1980 Y C N Mind Switch
Knight; Damon B 1979 Y N Rithian Terror    (aka Double Meaning in Rule Golden)
Knight; Damon B- 1995 Y SN Rule Golden     !2 stories good, 2 bad 2 94/B-
Knox; Calvin M C- 1984 Y C N One Asteroid Missing F253
Koontz; Dean R A- 1995 Y N Dark Of The Woods 2 13793   75/B
Koontz; Dean R D 1979 Y C N Darkness In My Soul
Koontz; Dean R B- 1987 Y N Fall Of The Dream Machine 22600
Koontz; Dean R C- 1982 Y N Fear That Man 23140
Koontz; Dean R F 1985 N Flesh In The Furnace
Koontz; Dean R A 1985 Y C N Hells Gate
Koontz; Dean R B+ 1984 Y C N Nightmare Journey
Koontz; Dean R C+ 1995 Y SS Soft Come The Dragons 2 13793   75/B
Koontz; Dean R B 1984 Y N Star Quest H70
Koontz; Dean R Strangers
Koontz; Dean R B- 1981 Y N Time Thieves 990
Koontz; Dean R N Vision; The Not Sf
Koontz; Dean R Watchers
Kornbluth; C.M. C N Critical Mass > Pohl
Kornbluth; C.M. F N Gladiator At Law > Pohl
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Kornbluth; C.M. B- N Gunner Cade > Judd; Cyril
Kornbluth; C.M. C+ N Mile Beyond The Moon
Kornbluth; C.M. A N Search The Sky > Pohl
Kornbluth; C.M. B N Space Merchants > Pohl
Kornbluth; C.M. C+ 1983 Y N Syndic
Kornbluth; C.M. B N Wolfbane > Pohl
Kornbluth; C.M. C N Wonder Effect > Pohl
Kotzwinkle; William C+ 1982 Y C N E.T.
Kube-Mcdowell; MichaelB- 1989 N Rc1 Odyssey   (Robot City 1) No end. W/ Asimov
Kube-Mcdowell; Michael Emprise
Kube-Mcdowell; Michael Enigma
Kube-Mcdowell; Michael Emprey
Kurtz; Katherin B 1990 Y N Legacy Of Lehr
Kuttner; Henry (Moore) Y N Creature Beyond Infinity Mint
Kuttner; Henry (Moore) C- 1984 Y C N Dark World
Kuttner; Henry (Moore) B 1976 N Earths Last Citadel W/ Moore
Kuttner; Henry (Moore) A 1979 N Fury
Kuttner; Henry (Moore) B- 1983 Y C N Mask Of Circe Old  -  W/ Moore
Kuttner; Henry (Moore) B+ 1983 Y N Mutant
Kuttner; Henry (Moore) D+ 1984 N Well Of Worlds
Kyle; David A D+ 1984 N Dragon Lensman
Lafferty; RA D 1993 SS Nine Hundred Grandmothers
Landis; Arthur NC 1990 N Camelot In Orbit
Lang; Simon B- 1981 Y C N E1 All The Gods Of Eisernon
Lang; Simon B+ 1981 Y C N E2 Elluvan Gift
Laumer; Kieth B 1982 Y C N Wi2 Assignment In Nowhere
Laumer; Kieth Beyond The Imperium >Assignment In ...
Laumer; Kieth B- 1984 SS Big Show
Laumer; Kieth A 1980 Y C N Bo2 Bolo
Laumer; Kieth B 1988 Y C N Catastrophe Planet
Laumer; Kieth SS Chrestomathy
Laumer; Kieth B+ 1980 Y N Day Before Forever & Thunderhold
Laumer; Kieth C+ 1981 Y N Earthblood W/ Brown; R.
Laumer; Kieth B+ 1980 Y N R1 Envoy To New Worlds 1963
Laumer; Kieth D 1978 N Fat Chance Not Sf
Laumer; Kieth N R Galactic Diplomat
Laumer; Kieth B+ 1984 Y N Galactic Odyssey
Laumer; Kieth D+ 1988 N Ol4 Galaxy Builder
Laumer; Kieth C 1980 N Ol Glory Game
Laumer; Kieth A 1981 Y N Great Time Machine Hoax
Laumer; Kieth B+ 1982 Y C SN Greylorn
Laumer; Kieth B 1977 N House In November
Laumer; Kieth C 1984 N Infinite Cage
Laumer; Kieth A 2007 Y SS Its A Mad Mad Mad Galaxy 2 77?/07A
Laumer; Kieth C- 1984 N Knight Of Delusions >Night Of Delusions
Laumer; Kieth A- 1983 Y C N Long Twilight
Laumer; Kieth C 1983 Y C N Moniters
Laumer; Kieth Y C N Night Of Delusions Orig Of Knight Of ...
Laumer; Kieth C+ 1979 Y N Wi3 Other Side Of Time
Laumer; Kieth A- 1980 Y C N Bo1 Plague Of Demons
Laumer; Kieth B 1984 N Planet Run W/ Dickson  -  Buy
Laumer; Kieth C- 1979 Y N R4 Retief & The Warlords 1968
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Laumer; Kieth Y C SS R? Retief Ambasador To Space
Laumer; Kieth B- 1984 SS R? Retief At Large Don't Read
Laumer; Kieth B- 1984 SS R? Retief Diplomat Arms
Laumer; Kieth C- 1980 Y N R3 Retief Emissary To The Stars 1966
Laumer; Kieth D 1988 SN R? Reteif In The Ruins
Laumer; Kieth B+ 1980 Y N R5 Retief Of The CDT 1969
Laumer; Kieth D 1985 N R? Retief To The Rescue
Laumer; Kieth A 1982 Y C N R6 Retiefs Ransom 1971
Laumer; Kieth B+ 1981 Y C N R2 Retiefs War 1965
Laumer; Kieth C- 1988 N R? Return Of Reteif
Laumer; Kieth C 1983 N Ol2 Shape Changer
Laumer; Kieth C+ 1984 SN Star Colony
Laumer; Kieth B 1983 Y C N Star Treasure
Laumer; Kieth N Thunderhead > Day Before Forever
Laumer; Kieth B- 1983 N Ol1 Time Bender
Laumer; Kieth B- 1989 Y C SS Time Tracks Other Authors
Laumer; Kieth B 1981 Y C N Time Trap
Laumer; Kieth B+ 1978 N Trace Of Memory
Laumer; Kieth B 1984 Y SN Undefeated
Laumer; Kieth C- 1982 N Ol3 World Shuffler
Laumer; Kieth B- 1995 Y C N Wi1 Worlds Of Imperium 2 F127   76/B-
Lee; Gentry C N Rama 2 >Clark
Lee; Tanith D- 1976 N Dont Bite The Sun
Lee; Tanith F+ 1992 N Kill The Dead
Leguin; Ursula K B 1979 Y N L5 City Of Illusions
Leguin; Ursula K B 1978 Y C N L1 Dispossesed; The
Leguin; Ursula K B 1980 Y N W3 Farthest Shore Juv
Leguin; Ursula K 1978 Y N Lathe Of Heaven
Leguin; Ursula K B+ 1978 Y N L4 Left Hand Of Darkness
Leguin; Ursula K D 1982 N Malafrena Donna read this
Leguin; Ursula K A- 1980 Y N L3 Planet Of Exile
Leguin; Ursula K B- 1978 Y N L2 Rocannons World
Leguin; Ursula K B 1980 Y N W2 Tombs Of Atuan Juv
Leguin; Ursula K A 1980 Y N W1 Wizard Of Earthsea Juv
Leguin; Ursula K B- 1981 Y N L0 Word For World Is Forest
Leiber; Fritz F 1978 N Big Time
Leiber; Fritz C+ 1984 N Gather Darkness
Leiber; Fritz C+ 1983 Y N Green Millennium 30300
Leiber; Fritz B- 1980 Y C N Night Of The Wolf
Leiber; Fritz 8 1987 Y SS Night Monsters 30300
Leiber; Fritz N Nights Black Agents
Leiber; Fritz N Pail Of Air
Leiber; Fritz N Shadows With Eyes
Leiber; Fritz C 1983 Y C N Ships To The Stars F285
Leiber; Fritz C- 1984 N Silver Eggheads
Leiber; Fritz A 1975 Y N Specter Is Haunting Texas 2 hardcover
Leiber; Fritz C+ 1981 N Swords & Deviltry
Leiber; Fritz N Tarzan & Valley Of Gold
Leiber; Fritz C 1977 N Wanderer
Leiber; Fritz N You're All Alone
Leinster; Murray X 1989 Y C N Brain Stealers 2 Old Grade A
Leinster; Murray C- 1988 N Checkpoint Lambda
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Leinster; Murray C+ 1987 Y N City On The Moon Old - - D277
Leinster; Murray B 1989 Y C N Creatures Of The Abyss Old
Leinster; Murray B 1981 Y N Md3 Doctor To The Stars
Leinster; Murray B 1983 Y N Forgotten Planet Old - - D146
Leinster; Murray A 1979 Y C N Four From Planet Five
Leinster; Murray B- 1987 Y N 3sn Get Off My World Old Style
Leinster; Murray B- 2003 Y N Greks Bring Gifts 2 Old & out of date  82/A
Leinster; Murray B 1980 Y C N Invaders Of Space
Leinster; Murray B- 1980 Y C N Land Of The Giants
Leinster; Murray B 1981 Y N Last Space Ship Hardcover
Leinster; Murray C+ 2007 Y C N Miners In The Sky (veryold, repetive) 2 81A-/07C+
Leinster; Murray N Monster From Earths End
Leinster; Murray B- 1984 Y SS Monsters & Such
Leinster; Murray N Murder Madness
Leinster; Murray B 1984 Y N Md0 Mutant Weapon D403
Leinster; Murray B- 1981 Y N Operation; Outer Space
Leinster; Murray A 1980 Y C N Other Side Of Nowhere
Leinster; Murray B- 1984 Y C N Pirates Of Zan D403
Leinster; Murray A- 1980 Y N Md1 S.O.S. From 3 Worlds
Leinster; Murray N Sidewise In Time
Leinster; Murray C- 1984 Y C N Space Captain M135
Leinster; Murray C= 2004 Y C N Space Gypsies 2 out of date    80/B+
Leinster; Murray 1976 Y C N Space Platform Old
Leinster; Murray B- 1995 Y ? N Talents Incorporated 2 76/B-
Leinster; Murray D+ 1987 N Time Tunnel
Leinster; Murray C+ 1981 Y C N T2 Timeslip TV Time Tunnel 2
Leinster; Murray A+ 1983 Y C SS Twists In Time
Leinster; Murray C 1983 N Wailing Asteroid
Leinster; Murray B- 1983 Y N Md2 World Is Taboo
Leonard; George H F 1982 N Alien
Lewis; C.S. B- 1977 N A3 Hideous Strength
Lewis; C.S. B 1974 N A1 Out Of Silent Planet
Lewis; C.S. D 1976 N A2 Perelandra
Long; Frank Belknap D- 1987 N Journey Into Darkness
Long; Frank Belknap B 1981 Y N Lest Earth B Conquered Juv
Long; Frank Belknap C 1984 Y ? N Space Station #1
Long; Frank Belknap D+ 1987 N Three Faces Of Time Old-Boring
Longyear; Barry B. A 1986 Y RS C3 Circus World
Longyear; Barry B. C1 City Of Baraboo
Longyear; Barry B. B- 1987 Y N C2 Elephant Song
Longyear; Barry B. B 1988 Y SN Em1 Manifset Destiny
Longyear; Barry B. F 1989 N Naked Came The Robot
Longyear; Barry B. C+ 1989 N Em2 Tomorrow Testiment
Lord; Jeffrey D+ 1979 N Bronze Age (Blade 1)
Lorrah; Jean A- 1988 Y N Sg Ambrov Keon Sime/Gen Novel
Lorrah; Jean B 1988 Y N Se3 Captives Of The Savage Empire
Lorrah; Jean B+ Y N Survivors; ST:TNG > Star Trek
Lorrah; Jean B+ 2002 Y N St Vulcan Acadamy Murder > Star Trek
Lory; Robert B 1987 Y N Eyes Of Bolsk 77710
Lory; Robert B+ 1981 Y N Harvest Of Hoodwinks 52180
Lory; Robert B- 1987 Y C N Identy Seven
Lory; Robert C+ 1981 Y N Masters Of The Lamp 52180
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Lowndes; Robert C+ 1994 Y C N Puzzle Planet 2 D485     76/C+
Ludlum; Robert C+ 1988 N Bourne Identity Action; Not Sf
Lundwall; Sam J D 1981 N Alices World
Lundwall; Sam J F 1981 N No Time For Heros
Lupoff; Richard A C+ 1986 N Sandworld
Lymington; John F 1977 N Froomb!
Mackelworth; R.W. C 1980 Y C N Starflight 3000
Mackintosh; Elizabeth >Tey; Josephine
Margroff; Robert E. B N Dragon's Gold > Anthony
Martin; Rod B- N R2 Playmasters > Dalmas
Mason; Douglas R C- 1983 Y C N Dilation Effect
Maxwell; Ann D- 1976 N Singer Enigma
May; Julian D 1989 N P1 Many Colored Land
McCaffrey; Anne B- 2001 Y N A3 Acorna's People   (audiobook) w/ Scarbourough
McCaffrey; Anne B+ 1995 Y N Pd1 All The Weyrs Of Pern
McCaffrey; Anne Chronicles of Pern; First Fall
McCaffrey; Anne CR 1991 N Coelura Juvenile
McCaffrey; Anne B+ 2002 Y C N Cs3 Crystal Line   2 95/B+
McCaffrey; Anne A 2002 Y C N Cs1 Crystal Singer  2 82/A-
McCaffrey; Anne A 1997 Y N R2 Damia romantic comedy
McCaffrey; Anne B 1997 Y N R3 Damia's Children part 1 > Lyon's Pride
McCaffrey; Anne B 2007 Y N Dp3 Death Of Sleep 2 95/C  w/ Nye; Jody
McCaffrey; Anne B- 1978 N Decision At Doona
McCaffrey; Anne B- 1985 Y C N Dp2 Dinosaur Planet Survivors
McCaffrey; Anne B- 1979 Y C N Dp1 Dinosaur Planet
McCaffrey; Anne A- 1997 Y N Pd2 Dolphins of Pern
McCaffrey; Anne A- 1980 Y N Pc3 Dragondrums S3
McCaffrey; Anne A 1978 Y C N Pb1 Dragonflight R1
McCaffrey; Anne B 1978 Y N Pb2 Dragonquest R2
McCaffrey; Anne B+ 1990 N Pd1? Dragonsdawn
McCaffrey; Anne Dragonseye AKA Red Star Rising
McCaffrey; Anne A+ 1978 Y N Pc2 Dragonsinger S2
McCaffrey; Anne B+ 1978 Y N Pc1 Dragonsong S1
McCaffrey; Anne B 1996 Y N FL1 Freedom's Landing not a complete story
McCaffrey; Anne B+ 2003 Y N FL2 Freedom's Choice
McCaffrey; Anne B 2003 Y N FL3 Freedom's Challenge story finally ends
McCaffrey; Anne B- 2003 Y N FL4 Freedom's Ransom afterthought
McCaffrey; Anne Dp5 Generation Warriors
McCaffrey; Anne B+ 1984 SS Get Off The Unicorn
McCaffrey; Anne B 2002 Y N Cs2 Killashandra 2 Hardcover
McCaffrey; Anne B 1997 Y N R4 Lyon's Pride part 2 > Damia's Chi…
McCaffrey; Anne B- 1985 Y N Pa1 Moreta -  Dragon Lady Of Pern P1   Bad Dumb End
McCaffrey; Anne B+ 1997 Y N P2 Power Lines w/ Scarborough; E.A.
McCaffrey; Anne A 1997 Y N P3 Power Play w/ Scarborough; E.A.
McCaffrey; Anne A 1995 Y C N P1 Powers That Be w/ Scarborough; E.A.
McCaffrey; Anne B- 1990 N Pd2? Renegades of Pern
McCaffrey; Anne A- 1995 Y C N R1 Rowan; The
McCaffrey; Anne A+ 1987 Y C N Pa2 Nerilka's Story P2
McCaffrey; Anne Red Star Rising  (UK of Dragonseye) >Dragonseye
McCaffrey; Anne N Restoree
McCaffrey; Anne B- 2006 Y N Ride Pegasus 2 78C+/06B-
McCaffrey; Anne B- 2005 N Dp4 Sassinak 2 95B  w/ Moon;  (SKIP)
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McCaffrey; Anne B- 1978 SN Ship Who Sang
McCaffrey; Anne B 1979 Y C N Pb3 White Dragon R3
Mcguire; John J B+ N Crises In 2140 > Piper
Mcintyre; Vonda N B+ N Enterprise - 1st Adventure >Startrek
Mcintyre; Vonda N B- N Entropy Effect >Startrek
Mcintyre; Vonda N A- C N Search For Spock >Startrek 3
Mcintyre; Vonda N B+ C N Voyage Home >Startrek 4
Mcintyre; Vonda N B+ C N Wrath Of Khan >Startrek 2
Merril; Judith Y N Years Greatest S.F. 57-58
Merritt; A D- 1977 N Metal Monster
Meyer; J.A. B- N Invaders Are Coming > Nourse
Monteleone; Thomas F  N Day Of Dragonstar > Bishcoff --Don't Read
Monteleone; Thomas F C+ N Night Dragonstar > Bishcoff
Moon; Elizabeth B N Dp3 Sassinak >McCaffrey
Moore; Catherine L C- 1996 Y C N Earths Last Citadel 2 76/B
Moore; Catherine L B- 1983 Y C N Judgement Night  Old; Odd 
Moore; Ward D 1975 N Bring The Jubilee
Morgan; Dan D 1975 N Neutral Stars
Morressy; John Nail Down The Stars > Stardrift
Morressy; John C 1987 Y N Stardrift
Morressy; John D 1978 N Under A Calculating Star
Murdock; M.S. B+ N Web Of The Romulans > Star Trek
Niven; Larry C 1993 N D2 Barsoom Project W/ Barnes
Niven; Larry A 1984 Y N Descent Of Anansi W/ Barnes
Niven; Larry A 1984 Y C N D1 Dream Park W/ Barnes
Niven; Larry B 2002 Y RS S1 Flight Of The Horse 2
Niven; Larry A+ 1994 Y N Flying Sorcerers 2 77/A+  w/ Gerrold
Niven; Larry A 1995 Y N P68 Gift From Earth 2 77/B
Niven; Larry B+ 2007 Y C SS Hole In Space 2 78B
Niven; Larry C 1983 N Inferno W/ Pournelle
Niven; Larry B 2002 Y C N I1 Integral Trees 2 missing?
Niven; Larry B 1997 Y SN Gh1 Long Arm Gill Hamilton 2 78/B  series P76
Niven; Larry A- 1981 Y C N M1 Magic Goes Away
Niven; Larry C 1983 SS M2 Magic May Return
Niven; Larry A- 1990 Y SN Man-Kzin Wars W/ Anderson & Ing
Niven; Larry B+ 2004 Y N Neutron Star 2
Niven; Larry A 1984 N Oath Of Fealty W/ Pournelle
Niven; Larry B+ 1998 Y C N Gh2 Patchwork Girl 2 85/B+
Niven; Larry B- 1995 Y N P67 Protector 2 77/B
Niven; Larry A- 2002 Y N S2 Rainbow Mars (includes most of Flight…) audiobook
Niven; Larry A- 2008 Y N R1 Ringworld 2 77B/08A-
Niven; Larry A- 2008 Y C N R2 Ringworld Engineers 2 82A/08A-
Niven; Larry B 2002 Y N Saturn's Race w/ Barnes
Niven; Larry B- 1985 Y SS Shape Of Space
Niven; Larry B+ 2002 Y C N I2 Smoke Ring 2 89/A-
Niven; Larry D+ 1984 SS Tales Of Known Space
Niven; Larry A- 1995 Y N P66 World Of Ptavvs 2 77/B
Niven; Larry B 2006 Y N World Out Of Time, A 2 78B
Nolan & Johnson B 1977 N Logans Run
Norman; John C+ 1976 Y N G5 Assassin Of Gor
Norman; John D 1979 N G12 Beasts Of Gor
Norman; John D 1976 N G7 Captive Of Gor
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Norman; John N G8 Hunters Of Gor
Norman; John B- 1976 N G9 Marauders Of Gor
Norman; John B 1976 Y N G4 Nomads Of Gor
Norman; John C 1976 Y N G2 Outlaws Of Gor
Norman; John A 1976 Y N G3 Priest-Kings Of Gor
Norman; John B 1976 Y C N G6 Raiders Of Gor
Norman; John B 1976 Y N G1 Tarnsmen Of Gor
Norman; John D+ 1978 N G10 Tribesmen Of Gor
Norton; Andre C+ 1988 Y N Android At Arms 2 B+ 1st Time
Norton; Andre B+ 1996 Y N B1 Beast Master 2 78/B
Norton; Andre B 1978 Y N Breed To Come
Norton; Andre B+ 1978 Y N Catseye
Norton; Andre B 1979 Y N Aw1 Crossroads Of Time
Norton; Andre C 1978 N Crystal Gryphon
Norton; Andre C+ 1978 Y N Dark Piper
Norton; Andre N Daybreak 2250 Ad
Norton; Andre B- 1997 Y N Tt3 Defiant Agents 2 82/B
Norton; Andre B- 1982 Y N Dragon Magic  Juv
Norton; Andre C+ 1977 Y C N Dread Companion
Norton; Andre C 1979 Y N M2 Exiles Of The Stars
Norton; Andre A+ 1982 Y C N Eye Of The Monster F147
Norton; Andre B- 1983 Y C N Forerunner
Norton; Andre B- 1978 N Forrunner Foray
Norton; Andre B 1997 Y N Tt2 Galactic Derelict 2 79/C
Norton; Andre B- 1982 Y C N Garan The Eternal  1st Ed.
Norton; Andre N Garin Of Tav > Garan The Eternal
Norton; Andre C+ 1982 Y C N Here Abide Monsters
Norton; Andre N High Sorcery
Norton; Andre ?? 1980 ? N Huon Of Horn Juv. Classic
Norton; Andre B+ 1979 N Ice Crown
Norton; Andre B- 1978 Y C N Iron Cage
Norton; Andre B- 1978 Y C N Jargoon Pard
Norton; Andre B 1980 Y N J1 Judgement On Janus
Norton; Andre B- 1997 Y N Tt4 Key Out Of Time 2 78/B
Norton; Andre A 1980 Y C N Knave Of Dreams
Norton; Andre A- Y N Last Planet > Star Rangers
Norton; Andre B- 1982 Y C N Lavender Green Magic  Juv
Norton; Andre B- 1996 Y N B2 Lord Of Thunder 2 78/B-
Norton; Andre C 1982 Y C N Merlins Mirror
Norton; Andre C 1978 Y C N M1 Moon Of Three Rings
Norton; Andre B 1978 Y N Night Of Masks
Norton; Andre C+ 1977 N No Night Without Stars
Norton; Andre C- 1978 N Opal Eyed Fan
Norton; Andre A 1981 Y N Operation Time Search
Norton; Andre C 1982 Y N Ordeal In Otherwhere
Norton; Andre N People Of The Crater > Garan The Eternal
Norton; Andre B+ 1981 Y C SN Perilous Dreams
Norton; Andre B 1995 Y N St2 Plague Ship 2 77/C
Norton; Andre B- 1995 Y N St3 Postemarked The Stars 2 77/C+
Norton; Andre C- 1979 N Quage Keep
Norton; Andre A- 1981 Y N Aw2 Quest Crosstime
Norton; Andre B+ 1995 Y N St1 Sargasso Of Space 2 77/C+
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Norton; Andre A- 1981 Y N Sea Siege F147
Norton; Andre B+ 1979 Y C N Secret Of Lost Race
Norton; Andre B 1979 Y N Shadow Hawk
Norton; Andre B+ 1995 Y N Sioux Spaceman 2 77/B
Norton; Andre C- 1982 N W5 Sorceress O Witchworld
Norton; Andre B+ 1982 Y N Star Born
Norton; Andre A 1981 Y N Star Gate
Norton; Andre C 1978 Y N Star Guard
Norton; Andre B+ 1981 Y N Star Hunter & Vodoo Planet
Norton; Andre B 1980 Y C N Sk2 Star Ka'at World  Juv
Norton; Andre A- 1979 N Star Ranger (Last Planet)   Buy 
Norton; Andre C 1977 N Starmans Son
Norton; Andre A- 1983 Y C N Stars Are Ours
Norton; Andre B 1977 N Storm Over Warlock
Norton; Andre C- 1977 N W3 Three Against Witchwrld
Norton; Andre B+ 1997 Y N Tt1 Time Traders 2 78/C
Norton; Andre N W6 Trey Of Swords
Norton; Andre C+ 1977 Y N Z2 Uncharted Stars
Norton; Andre C+ 1980 Y N J2 Victory On Janus
Norton; Andre B+ 1982 Y C N Voorloper
Norton; Andre D 1977 N W4 Warlock Of Witchworld
Norton; Andre B 1977 Y N W2 Web Of Witchworld
Norton; Andre B 1977 Y N W1 Witchworld
Norton; Andre A- 1981 Y C N Wraiths Of Time
Norton; Andre B 1979 Y N X Factor
Norton; Andre D 1985 N W0 Year Of Unicorn
Norton; Andre B 1978 Y C N Yurth Burden
Norton; Andre C 1979 N W7 Zarsthors Bane
Norton; Andre B+ 1979 Y N Z1 Zero Stone
Norton; W F 1978 N Day Of Animals
Nourse; Alan E B 1994 Y C N Blade Runner 2 76/B
Nourse; Alan E N Counterfiet Man
Nourse; Alan E B- 1984 Y C N Invaders Are Coming Violent
Nourse; Alan E A+ 1983 N Man Obsessed Buy 
Nourse; Alan E A+ Y C N Mercy Man > Man Obsessed
Nourse; Alan E B 1983 Y SS Psi High & Others
Nourse; Alan E B- 1978 Y C N Raiders From The Rings
Nourse; Alan E B- 2006 Y N Rocket To Limbo   (old - out of date) 2 87B  Juv-Idealistic
Nourse; Alan E N Rx For Tomorrow
Nourse; Alan E B- 1978 Y N Scavengers In Space
Nourse; Alan E N Star Surgeon
Nourse; Alan E A+ 1978 Y SS Tiger By The Tail Hard
Nourse; Alan E C+ 1984 N Trouble On Titan Juv
Nourse; Alan E B 1980 Y N Universe Between
Nunes; Claud & Rhoda 1977 Y N Recoil 71082
Nye; Jody Lynn C N Dp4 Death of Sleep >McCaffrey
O'donnell; K.M. D- 1984 N Dwellers Of The Deep
Oltion; Jerry B N Ct6 Where Sea Meets Sky Star Trek book
Petaja; Emil Y Db Caves Of Mars Db
Petaja; Emil C 1984 Y C N Doom Of Green Planet
Petaja; Emil C- 1983 Y C N Star Mill !Old!
Piper; H. Beam 1979 Y N Cosmic Computer
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Piper; H. Beam B+ 1983 Y N Crisis In 2140 D227
Piper; H. Beam A 1983 Y C SN Federation
Piper; H. Beam C- 1983 Y C N First Cycle
Piper; H. Beam A 1983 Y N Four Day Planet & Lone Star P.
Piper; H. Beam B 1989 Y N F3 Fuzzy Bones by Tuning; William
Piper; H. Beam B- 1995 Y N F2 Fuzzy Sapiens 2 77/B
Piper; H. Beam A- 1995 Y N F1 Little Fuzzy 2 77/B
Piper; H. Beam B 1983 Y C N Lord Kalvan Of Otherwhen
Piper; H. Beam N Planet For Texans Buy 
Piper; H. Beam C+ 1982 Y C N Space Viking
Piper; H. Beam B 1984 N Uller Uprising Don't Read
Piserchia; Doris C+ 1988 N Earthchild
Piserchia; Doris C+ 1988 N Spaceling
Pohl; Fredrick A 1981 Y N Age Of The Pussyfoot
Pohl; Fredrick F 1982 N Art & Agony Of Collaboration
Pohl; Fredrick C 1982 N G2 Beyond Blue Event Horizon
Pohl; Fredrick C 1983 N Case Against Tomorrow
Pohl; Fredrick C 1980 Y N Critical Mass W/ Kornbluth
Pohl; Fredrick D+ 1984 SS Day Million
Pohl; Fredrick N Drunkards Walk
Pohl; Fredrick N Edge Of The City
Pohl; Fredrick C 1977 N Farthest Star
Pohl; Fredrick D+ 1978 N G1 Gateway
Pohl; Fredrick F 1982 N Gladiator At Law W/ Kornbluth
Pohl; Fredrick D- 1985 N G3 Heechee Rendezvous
Pohl; Fredrick D 1981 N In The Problem Pit
Pohl; Fredrick F 1988 N Man Plus
Pohl; Fredrick D 1980 Y C N Plague Of Pythons
Pohl; Fredrick F 1982 N Prefered Risk
Pohl; Fredrick B- 1980 N R1 Reefs Space > Starchild
Pohl; Fredrick C- 1980 N R3 Rogue Star > Starchild
Pohl; Fredrick A- 1995 Y C N Search The Sky 3 75/A  W/ Kornbluth
Pohl; Fredrick D+ 1981 N Slave Ship
Pohl; Fredrick B 1981 Y N Space Merchants W/ Kornbluth
Pohl; Fredrick Y C SS Star Series 1
Pohl; Fredrick SS Star Series 2
Pohl; Fredrick SS Star Series 3
Pohl; Fredrick Y C SS Star Series 4
Pohl; Fredrick Y C SS Star Series 5
Pohl; Fredrick Y C SS Star Series 6
Pohl; Fredrick C- 1980 N R2 Starchild > Starchild Tril.
Pohl; Fredrick C Y N Starchild Trilogy (R1-R3)
Pohl; Fredrick C+ 1979 Y N U2 Undersea City
Pohl; Fredrick C+ 1981 Y N U3 Undersea Fleet
Pohl; Fredrick B- 1976 Y C N U1 Undersea Quest
Pohl; Fredrick B 1980 Y N Wolfbane W/ Kornbluth
Pohl; Fredrick C 1981 Y N Wonder Effect W/ Kornbluth
Pournelle; Jerry B- 1982 N Birth Of Fire
Pournelle; Jerry B- 1988 Y N J2 Clan & Crown W/ Green
Pournelle; Jerry C 1983 N Exiles To Glory
Pournelle; Jerry C N Inferno > Niven
Pournelle; Jerry B+ 1988 Y N J1 Janissaries W/ Green
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Pournelle; Jerry B+ Y N King Davids Spaceship > Spaceship For ...
Pournelle; Jerry C- 1983 N M2 Mercenary
Pournelle; Jerry A N Oath Of Fealty > Niven
Pournelle; Jerry B+ 1982 Y C N Spaceship For The King
Pournelle; Jerry C- 1988 N J3 Storms Of Victory
Pournelle; Jerry C+ 1983 N M1 West Of Honor
Powers; Tim C+ 1989 N Drawing Of The Dark
Pratchett; Terry C+ 1989 N Colour Of Magic
Pratchett; Terry C+ 1978 N Dark Side Of The Sun
Pratchett; Terry C+ 1989 N Light Fantastic
Pratt; Fletcher C- 1977 N Blue Star
Preston; Douglas C 2008 N Codex, The Mystery, audiobook
Preuss; Paul B 1989 Y N Vp1 Breaking Strain Clark's Venus Prime Series
Preuss; Paul B- 1993 N Vp5 Diamond Moon Clark's Venus Prime Series
Preuss; Paul B- 1990 N Gates of Heaven
Preuss; Paul C+ 1990 Y N Vp3 Hide And Seek Clark's Venus Prime Series
Preuss; Paul B 1989 Y N Vp2 Maelstrom Clark's Venus Prime Series
Preuss; Paul C- 1992  N Vp4 Medusa Encounter Clark's Venus Prime Series
Price; E. Hoffman C- 1982 N Operation Missfit
Priest; Christopher C+ 1985 N Inverted World
Priest; Christopher C- 1985 N Perfect Lover
Prince; Don B- 1988 Y N Swoop Old; Not Sf; Hard
Pullman, Philip B+ 2004 N DM1 Golden Compase Kid/Adult
Putney; Susan K A- 1981 Y N Against Arcturus 990
Queen; Ellery 1984 N Chinese Orange Tape
Queen; Ellery 1984 N Siamese Twin Tape
Queen; Ellery 1984 N Spanish Cape Tape
Rachham; John A 1980 Y N Alien Sea H40
Rachham; John A- 1985 Y C N Beasts Of Kohl G592
Rachham; John B- 1980 Y N Beyond Capella 5595
Rachham; John B+ 1980 Y N Flower Of Doradil 24100
Rachham; John A 1987 Y N Ipomoea 2 37250
Rachham; John A 1981 Y C N Proxima Project H91
Radio Shows B 1992 Y R I Love A Mystery - Cries in the Night
Radio Shows C- 1991 Y R Mr Keen - Rented Cottage
Radio Shows B 1991 Y R Bulldog Drummond - Disappearing Ink
Radio Shows D 1991 R FBI - Carnival Act
Radio Shows F 1991 R Gangbusters - Supersonic Safe
Radio Shows D 1991 R Green Hornet - Drops a Hint
Radio Shows C 1991 R Dragnet - Big Slug
Radio Shows C+ 1991 R Thin Man - Nora's Night
Radio Shows C- 1991 R Fat Man - Murder is the Medium
Randall; Marta C+ 1989 N City In The North
Randall; Robert C+ 1989 N Dawning Light
Rankine; John B+ 1979 N Bromius Phenomenon
Rankine; John C+ 1987 Y N Operation Umanaq
Reed; Kit D- 1988 N Magic Time
Reeves-Stevens; J & G A N Prime Directive > Star Trek
Reeves-Stevens; J & G D N Federation > Star Trek
Reich; Chrostopher F 2008 N Devil's Banker Spy/Terrorist,  audio
Rendell; Ruth A- 1990 T Shake Hands Forever TV Mystery
Resnick; Mike C 1988 N Soul Eater
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Reynolds; Mac C- 1976 N Five Way Secret Agent & Mercenary
Reynolds; Mac D+ 1985 Y N Rival Rigelians G632
Reynolds; Mac Y N Space Barbarians 77710
Rhodan; Perry C- 1977 N Target Star
Richmond; Walt & Leig B+ 1995 Y N Challenge The Hellmaker 2 77/A+
Richmond; Walt & Leig N Gallagher's Glacier
Richmond; Walt & Leig B 1987 Y N Phase Two
Richmond; Walt & Leig N Phoenix Ship > Phase Two
Richmond; Walt & Leig B 2006 Y C N Probability Corner  (out of date) 2 87B
Richmond; Walt & Leig N Siva!
Roberts; Jane F+ 1983 Y N The Rebellers F215
Roberts; John Maddox B 1991 N Space Angel
Roberts; Peter C+ 1992 N Corobite Mines
Robinson; Spider & JeanneB- 1990 N Stardance Don't Read
Rocklyne; Ross D 1982 Y Sun Destroyers Old     DB
Roddenberry; Gene A+ N ST1: The Motion Picture >Star Trek
Rossiter; Oscar D+ 1978 N Tetrasomy Two
Rowley; Christopher D+ 1991 N Black Ship
Rowley; Christopher B- 1991 Y N S1 Starhammer
Rowley; Christopher C+ 1991 N S2 Vang Too violent
Rowley; Christopher D 1995 N War For Eternity
Rowling; J.K. B- 2001 N HP1 Harry Potter - Sorcerer's Stone Teen book
Russ; Johanna C- 1989 N Picnic On Paradise (D+  ?)
Russell; Eric Frank B 1983 Y SS Deep Space /Select.
Russell; Eric Frank D 1984 N Dreadfull Sanctuary Don't Read
Russell; Eric Frank A 1980 Y C N Great Explosion
Russell; Eric Frank C+ 1980 Y N Mindwarpers Mystery
Russell; Eric Frank B 2002  N Sentinels From Space 2 87/B
Russell; Eric Frank B+ 1980 Y C N Sinister Barrier Damaged;Buy
Russell; Eric Frank B 1983 Y SN Six Worlds Yonder D315
Russell; Eric Frank D 1983 Y C SS Somewhere A Voice
Russell; Eric Frank B+ 1983 Y N Space Willies D315
Russell; Eric Frank A- 1983 Y C N Wasp Poor Condition
Saberhagen; Fred C+ 1995 RS Berserker
Saberhagen; Fred A- N Coils > Zelazny
Saberhagen; Fred C+ 1982 N Mask Of The Sun
Saberhagen; Fred D+ 1985 N Thorn
Saberhagen; Fred C- 1984 N Veils Of Azlaroc
Sadler; Barry 1986 N Casca: Panzer Solder Wrong Type
Sargent; Pamela D+ 1985 N Cloned Lives
Sayers; Dorthy L B- 1987 T Pw Gaudy Night Peter Wimsey  PBS-Tv
Sayers; Dorthy L B- 1987 T Pw Have His Carcus PBS-Tv
Sayers; Dorthy L C+ 1987 T Pw Strong Poison PBS-Tv
Scarborough; EA B- A1 Acorna's People >McCaffry
Scarborough; EA A Pb1 Powers That Be >McCaffry
Scarborough; EA B+ Pb2 Power Lines >McCaffry
Scarborough; EA A Pb3 Power Play >McCaffry
Schmitz; James H Agent of Vega
Schmitz; James H Demon Breed
Schmitz; James H A+ 1983 Y C N Eternal Frontiers
Schmitz; James H A- 1989 Y N Legacy
Schmitz; James H T3 Lion Game
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Schmitz; James H A- N Tale Of Two Clocks Orig. Of Legacy
Schmitz; James H B 1994 Y SN T2 Telzey Toy
Schmitz; James H T1 Universe Against Her
Schmitz; James H Witches Of Karres
Scortia; Thomas N D 1978 N Artery Of Fire
Scott; Justin A- 1982 N Shipkiller Not Sf
Shatner; William D- N Preserver Star Trek Book
Shaw; Bob D+ 1984 N Dagger Of The Mind
Shaw; Bob D 1982 Y C N Ground Zero Man
Shaw; Bob B+ 2003 Y N Medusas Children 2 80/A
Shaw; Bob A 1977 Y N Night Walk
Shaw; Bob C- 1977 N One Million Tomorrows
Shaw; Bob B+ 1979 Y N O1 Orbitsville 2
Shaw; Bob D+ 1989 Y N O2 Orbitsville Departure
Shaw; Bob C 1982 Y C N Other Days; Other Eyes
Shaw; Bob B 1980 Y N Palace Of Eternity
Shaw; Bob C+ 1989 N Pt1 Ragged Astronauts
Shaw; Bob B- 1979 Y C N Shadow Of Heaven
Shaw; Bob B 1980 Y C N Ship Of Strangers
Shaw; Bob B- 1981 Y C N Tomorrow Lies In Ambush
Shaw; Bob C+ 1980 Y N Two Timers
Shaw; Bob B- 2005 Y C N Vertigo 2 83A-
Shaw; Bob B 1983 Y N Who Goes Here
Shaw; Bob Pt2 Wooden Spaceships Don't Read
Shaw; Bob B 1978 Y ? N Wreath Of Stars
Sheckley; Robert D 1977 N Mindswap
Sheffield; Charles C+ 1989 RS Mcandrew Chronicles
Sheffield; Charles B- 1990 N Sight Of Proteus
Shimerman; Armin D- 2006 N DS9 Rule, The  (DS9 #23) couldn't finish w/ George
Silverberg; Robert D+ 1984 Y N Collision Course F123
Silverberg; Robert C+ 1984 Y C N Next Stop The Stars F145
Silverberg; Robert D- 1987 N Nightwings
Silverberg; Robert C+ 1984 N Open The Sky F145
Silverberg; Robert C+ 1984 Y C N Seed Of Earth
Silverberg; Robert B- 1984 Y C N Silent Invaders F195
Silverberg; Robert B- 1984 Y N Stepsons Of Terra D311
Silverberg; Robert B- 1984 Y N Thirteenth Immortal D223
Silverberg; Robert B+ 1984 Y N Those Who Watch
Silverberg; Robert C- 1984 N Time Hoppers
Silverberg; Robert C 1988 N Time Of The Great Freeze
Silverberg; Robert F 1984 N Tower Of Glass
Silverberg; Robert F 1985 N World Inside
Simak; Clifford D A 1986 Y C N All Flesh Is Grass 2 Classic Aliens
Simak; Clifford D A 1981 Y C N Cemetery World
Simak; Clifford D B- 2008 Y N Choice Of Gods, A 2 78?/08B-
Simak; Clifford D B 1978 Y ? N City
Simak; Clifford D C- 1982 N Cosmic Engineers  Old
Simak; Clifford D C- 1980 N Destiny Doll
Simak; Clifford D C+ 1977 Y C N Enchanted Pilgramage
Simak; Clifford D C 1979 Y C N Fellowship Of The Talisman
Simak; Clifford D N First He Died > Time And Again
Simak; Clifford D A+ 1997 Y N Goblin Reservation 2 77/A+
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Simak; Clifford D B- 1982 Y N Heritage Of Stars Hard
Simak; Clifford D C 1988 N Highway Of Eternity
Simak; Clifford D A- 2005 Y C N Mastadonia 2 79B+
Simak; Clifford D B 1982 Y C N Our Childrens Children
Simak; Clifford D B- 1984 Y N Out Of Their Minds
Simak; Clifford D C+ 1983 N Project Pope
Simak; Clifford D B+ 1995 Y N Ring Around The Sun 2 77/A+
Simak; Clifford D C 1977 Y C N Shakspears Planet
Simak; Clifford D B 1980 Y C N So Bright The Vission H95
Simak; Clifford D B 1984 Y N Special Deliverance Hard
Simak; Clifford D D 1984 SS Strangers In Universe
Simak; Clifford D B 2005 Y C N They Walked Like Men  (out of date) 2 81A+
Simak; Clifford D C- 1983 N Time & Again
Simak; Clifford D B- 2006 Y C N Time Is The Simplest Thing (out of date) 2 77B
Simak; Clifford D A- 1982 Y N Trouble With Tycho D519
Simak; Clifford D B 1981 Y N Visitors; The
Simak; Clifford D A+ 1977 Y N Waystation
Simak; Clifford D B+ 1995 Y C N Werewolf Principle 2 77/A+
Simak; Clifford D D+ 1986 N Where The Evil Dwells Fantasy
Simak; Clifford D C 1975 N Why Call Back From Heaven
Simak; Clifford D B 1984 Y SN Worlds Without End
Smith; Cordwainer B 2002 Y C N N! Norstrilia 3 86/B+
Smith; Cordwainer D 2002 N N1 Planet Buyer Norstrilia, part 1
Smith; Cordwainer 1979 Y C N Quest Of Three Worlds
Smith; Cordwainer 2002 N N2 Underpeople Norstrilla, part 2
Smith; E.E. 'doc' C+ 1976 Y N S1 Skylark Of Space
Smith; E.E. 'doc' N S2 Skylark Three
Smith; E.E. 'doc' C 1987 N Spacehounds Of The Ipc Old-Boring
Smith; George C- Y C N Path Of Unreason
Smith; L. Neil B- 1989 Y N A6 Brightsuit Macbear B1
Smith; L. Neil NC 1990 N Crystal Empire
Smith; L. Neil C 1986 N A5 Gallatin Divergence
Smith; L. Neil C N Mindharp Of The Sharu > Star Wars
Smith; L. Neil C 1985 N A3 Nagasaki Vector
Smith; L. Neil B- 1985 Y C N A1 Probability Broach W1
Smith; L. Neil C- 1989 N A7 Taflak Lysnadra B2
Smith; L. Neil C 1985 N A-1 Their Majestys Bucketrs
Smith; L. Neil B 1985 Y N A4 Tom Paine Maru
Smith; L. Neil B- 1985 Y C N A2 Venus Belt W2
Snyder; Gene B 1990 N Ogden Enigma Not SF
Spielberg; Steven C+ 1980 Y C N Close Encounters Third Kind
Spinrad; Norman D+ 1987 N Agent Of Chaos
Stableford; Brian M C 1982 Y C N D5 Balance Of Power
Stableford; Brian M D+ 1982 N Castaways Of Tanagar
Stableford; Brian M F 1985 N Challenge Chaos
Stableford; Brian M B+ 1981 Y C N D4 City Of The Sun
Stableford; Brian M B- 1995 Y N Cradle Of The Sun 2 12140    75/B-
Stableford; Brian M A- 1982 Y C N D2 Critical Threshold
Stableford; Brian M F 1981 N Di1 Days Of Glory
Stableford; Brian M N Di3 Days Of Wrath Don't Read
Stableford; Brian M C 1979 Y C N G5 Fenris Device
Stableford; Brian M B 1979 Y C N D1 Florians
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Stableford; Brian M B 1979 Y C N G1 Halycon Drift
Stableford; Brian M B+ 1985 Y N Journey To The Center
Stableford; Brian M F N Di2 Kingdom O Beast Don't Read
Stableford; Brian M C 1979 N Mind Riders
Stableford; Brian M C+ 1981 Y C N G4 Paradise Game
Stableford; Brian M C+ 1980 Y C N D6 Paradox Of The Sets
Stableford; Brian M B- 1979 Y C N G3 Promised Land
Stableford; Brian M N Realms Of Tartarus
Stableford; Brian M D+ 1983 Y C N G2 Rhapsody In Black
Stableford; Brian M C- 1979 Y C N G6 Swan Song
Stableford; Brian M A- 1978 Y C N D3 Wildebloods Empire
Starr; Bill C 1995 C N F2 Treasure Of Wonderwhat 2 77/B
Starr; Bill A- 1994 Y C N F1 Way To Dawnworld 2 76/A-
Star Trek Listing B- 1985 N Cl Abode Of Life Correy
Star Trek Listing B 2000 N Bd1 Badlands 1 of 2 Wright; Susan
Star Trek Listing B- 2000 N Bd1 Badlands 2 of 2 Wright; Susan
Star Trek Listing B- 1993 N M Death Count Graff
Star Trek Listing B 1981 Y C N Cl Devil World Eklund
Star Trek Listing B+ 1990 Y N Cl Enterprise; 1st Adventure Mcintyre
Star Trek Listing B- 1985 N Cl Entropy Effect Mcintyre
Star Trek Listing D 1995 N  Federation Reeves-Stevens
Star Trek Listing A 1981 Y C N Cl Galactic Whirlpool Gerold
Star Trek Listing A- 1993   N Ng Imzadi                       BUY!! David; Peter
Star Trek Listing B- 2007 Y N Cl Ishmael  (slow and wordy) 2 Hambly  86A
Star Trek Listing C+ 1985 N Cl Klingon Gambit Vardeman
Star Trek Listing B- 1992 Y N Cl Legacy Friedman
Star Trek Listing N Cl Mudds Angels Lawrence
Star Trek Listing B 1980 N Cl Perrys Planet Haldeman
Star Trek Listing 1979 N Cl Planet Of Judgement Haldeman
Star Trek Listing D- 2000 N Preserver Shatner
Star Trek Listing D 1980 N Cl Price Of The Phoenix Marshak
Star Trek Listing A 1991 N Cl Prime Directive Reeves-Stevens
Star Trek Listing C 1993 N M Probe Bonanno; M
Star Trek Listing B 1993 N Ng Q-In-Law David; Peter
Star Trek Listing B+ 2000 N Seven Of Nine Golden
Star Trek Listing 1979 Y C SS Cl S.T. 123456789012 Blish   Need 2 &4 in 1sts
Star Trek Listing 1976 Y C SS An S.T. Log 1-0 Foster, Animated, Need 10
Star Trek Listing 1979 N Cl Spock Messiah Cogswell
Star Trek Listing Y N Cl Spock Must Die Blish
Star Trek Listing A+ 1980 Y C N M St1; The Motion Picture Roddenberry
Star Trek Listing B+ 1982 Y C N M St2; The Wrath Of Khan Mcintyre
Star Trek Listing A- 1985 Y C N M St3; The Search For Spock Mcintyre
Star Trek Listing B+ Y C N M St4; The Voyage Home Mcintyre
Star Trek Listing B- Y C N M St5; The Final Frontier Dillard
Star Trek Listing C+ 1992 Y C N M St6; The Undiscovered Country Dillard
Star Trek Listing N Cl Starless World Eklund
Star Trek Listing B+ 1989 Y N Ng Survivors Lorrah
Star Trek Listing C+ 1985 N Ng Trek To Madworld Goldin
Star Trek Listing A+ 1985 Y N Cl Uhuras Song Kagen
Star Trek Listing B+ 2002 Y N Cl Vulcan Acadamy Murder  2x 85 A Lorrah
Star Trek Listing B+ 1992 Y N Cl Web Of The Romulans Murdock
Star Trek Listing B 2000 N Ct6 Where Sea Meets Sky Oltion
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Star Trek Listing 1978 N Cl World W/Out End Haldeman
Star Wars Listings D 2001 N Chhildren of the Jedi Hambly
Star Wars Listings C- 1980 Y C N Sw5 Empire Strikes Back M2
Star Wars Listings C 1986 N Mindharp Of The Sharu Smith
Star Wars Listings A 1983 Y C N Sw6 Return Of Jedi M3   Kahn
Star Wars Listings C 1979 Y C N Splinter Minds Eye Foster
Star Wars Listings B 1977 Y C N Sw4 Star Wars M1   Lucas
Star Wars Listings B 2001 N X-Wing Solo Commans Allston
Stashef; Christopher B 1989 Y N Her Majesty's Wizzard
Stashef; Christopher C 1990 N W2 King Kobold Revived
Stashef; Christopher B+ 1990 Y N W1 Warlock In Spite Of Himself
Stashef; Christopher B- 1991 N Wizard In Bedlam
Stephenson; Andrew M C+ 1982 N Nightwatch
Stewart; Gordon R B 1980 Y C N Earth Abides
Stout; Rex A 1984 N Three Witnesses Nero Wolf
Stout; Rex A- 2004 Y N Too Many Clients
Stout; Rex B- 1984 N Triple Jeopardy Nero Wolf
Strahan; Kay D 2001 N Desert Moon Mystery  (1928!)
Strike; Jeremy B- 1980 Y N Promising Planet 24100
Strugatsky; Arkady D- 1978 N Roadside Picnic
Sturgeon; Theodore F 1988 N Cosmic Rape
Sturgeon; Theodore N Dreaming Jewels (Original Synthetic Man)
Sturgeon; Theodore C+ 1988 N More Than Human
Sturgeon; Theodore A- 1983 Y N Synthetic Man
Sturgeon; Theodore B 1991 Y N Venus Plus X A Classic
Sutton; Jeff B- 1980 Y N Man Who Saw Tomorrow H95
Sutton; Jeff B+ 1988 Y N Mind Blocked Man
Sutton; Jeff B- 1987 Y N Whisper From The Stars
Swan; Thomas Burnett C- 1983 N Weirwoods
Swanwich; Michael C+ 2001 N In The Drift
Takei; George C+ N Mirror Friend; Mirror Foe > Asprin
Temple; William F Y N Automated Goliath F129
Temple; William F C- 1979 Y N Battle On Venus F195
Temple; William F B 1982 Y C N Shoot At The Moon
Temple; William F C 1979 Y N Three Suns Of Amara F129
Tenn; William C- 1983 SS Time In Advance
Terman; Douglas C- 1982 N First Strike Not Sf
Tey; Josephine B 1986 T Brat Farrar PBS-Tv Mystery
Tey; Josephine A- 1989 N Brat Farrar (The Novel)
Tey; Josephine Daughter Of Time
Tey; Josephine Franchise Affair
Tey; Josephine C+ 1989 N Man In The Queue
Tey; Josephine Miss Pym Disposes
Tey; Josephine Singing Sands
Tey; Josephine To Love & To Be Wise
Tilley; Patrick C 1983 N Fade-Out
Tolkien; J.R.R. A 2003 Y N 1 Hobbit BBC Radio Play CD
Tolkien; J.R.R. B- 2003 Y N 2,3,4 Lord Of The Rings BBC Radio Play CD
Tolkien; J.R.R. B 2009 Y N T2 Fellowship Of The Ring 3 75A+   out of date
Tolkien; J.R.R. A- 2009 Y N T1 Hobbit 2 75A+  out of date
Tolkien; J.R.R. A+ 1975 Y N T4 Return Of The King 2 fantasy
Tolkien; J.R.R. A+ 1975 Y N T3 Two Towers 2 fantasy

2009-06-JTB-Books.xls          6/3/09      Page 36



2009-06-JTB-Books.xls    6/3/09    Page 37
Author Gd Yr O C T Ser X Notes

Tompkins; Walter B 1978 N Dx Brings Danger Not Sf
Trebor; Robert C- 1985 N An Xt Called Stanley
Trimble; Louis B+ 2002 Y C N Bodelan Way 2 81/B+
Trimble; Louis A- 2004 Y C N City Machine 2 81/A-
Trimble; Louis B- 1983 Y N Guardians Of The Gate
Trimble; Louis B+ 1983 Y N Noblest Experiment In The Galaxy 11560
Trimble; Louis B- 1986 Y C N Wandering Variables
Tubb; E.C. 1977 N Alien Dust Old
Tubb; E.C. B 1980 Y N C.O.D. Mars H40
Tubb; E.C. D- 1980 N Century Of The Manikin
Tubb; E.C. B 1979 Y N D2 Derai 89301
Tubb; E.C. C 1977 N D18 Incident On Ath
Tubb; E.C. C- 1983 Y N D5 Jester At Scar 81610
Tubb; E.C. C- 1982 Y C N  D10 Jondelle
Tubb; E.C. B 1978 Y N D4 Kalin 42800
Tubb; E.C. B 1977 Y N D6 Lallia 71082
Tubb; E.C. B 1978 Y N D9 Mayene
Tubb; E.C. B+ 1985 Y N Moonbase
Tubb; E.C. B 1983 Y N S.T.A.R. Flight
Tubb; E.C. Y N Scatter Of Stardust 79975
Tubb; E.C. C- 1977 N D15 Spectrum Forgotten Sun
Tubb; E.C. D- 1985 N Stardeath
Tubb; E.C. B 1978 Y N D7 Technos 79975
Tubb; E.C. B- 1991 N D31 Temple of Truth Finds Earth's Coordinants
Tubb; E.C. C 1982 Y N D3 Toyman 23140
Tubb; E.C. B 1978 Y C N D8 Veruchia
Tubb; E.C. C- 1987 N D20 Web Of Sand
Tubb; E.C. B 1979 Y N D1 Winds Of Gath 89301
Tucker; Wilson N Chinese Doll; The
Tucker; Wilson N City In The Sea
Tucker; Wilson N Dove; The
Tucker; Wilson N Hired Target
Tucker; Wilson B- 1987 Y N Ice And Iron 2 hardcover
Tucker; Wilson N Keep Or Kill
Tucker; Wilson N Last Stop
Tucker; Wilson A 1983 Y N Lincoln Hunters 2
Tucker; Wilson C 1977 N Long Loud Silence
Tucker; Wilson N Man In My Grave
Tucker; Wilson N Man From Tomorrow > Wild Talent
Tucker; Wilson B+ 1979 N Procession Of Damned
Tucker; Wilson N Red Hering
Tucker; Wilson A 2006 Y C N Resurection Days 2 83A-
Tucker; Wilson N Stalking Man
Tucker; Wilson N Time Bomb (Original Of 'Tomorrow+X')
Tucker; Wilson B+ 2002 Y N Time Masters 2 81/B+
Tucker; Wilson B 1983 Y SS Time-X
Tucker; Wilson N Tombaugh Station
Tucker; Wilson A- 1987 Y N Tomorrow Plus X
Tucker; Wilson B+ 1982 Y N Wild Talent
Tucker; Wilson B+ 2002 Y N Year Of The Quiet Sun 2 83/A-
Tuning; William B N Fuzzy Bones >Piper
Vance; Jack D+ 1983 Y C N Dragon Masters F185
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Vance; Jack B- 1983 Y N Five Gold Bands F185
Vance; Jack C- 1976 N Showboat World
Van Vogt; A.E. N 200000000 Ad > Book Of Ptath
Van Vogt; A.E. B 1983 Y C N Anarchistic Colosis
Van Vogt; A.E. 1983 SS Away & Beyond
Van Vogt; A.E. C- 1982 N Battle Of Forever
Van Vogt; A.E. A 1981 Y ? N Beast; The
Van Vogt; A.E. B+ 1981 Y SS Blal; The
Van Vogt; A.E. N Book Of Ptath > Ptath
Van Vogt; A.E. 1979 Y N Changeling; The
Van Vogt; A.E. A- 1980 Y N Children Of Tomorrow
Van Vogt; A.E. C- 1982 N Darkness On Diamondia
Van Vogt; A.E. B+ 1981 Y SS Destination Universe
Van Vogt; A.E. N Earth Factor X > Secret Galactics
Van Vogt; A.E. B 1982 Y N L1 Empire Of Atom  Hard
Van Vogt; A.E. A- 2007 Y C N Future Glitter 2 80B+/07A-
Van Vogt; A.E. B 1982 Y ? SS Gryb; The
Van Vogt; A.E. A- 1981 Y N House That Stood Still
Van Vogt; A.E. B+ 1981 Y C N Man With Thousand Names
Van Vogt; A.E. B 1981 Y C N Masters Of Time
Van Vogt; A.E. B 1980 Y N Mind Cage
Van Vogt; A.E. B 1983 Y N Mission To The Stars
Van Vogt; A.E. B 1983 N Mixed Men Buy 
Van Vogt; A.E. CR 1990 Y N Na3 Null-A Three
Van Vogt; A.E. C 1984 SS Pendulum
Van Vogt; A.E. B+ 1981 Y N Planets For Sale
Van Vogt; A.E. B+ 1981 Y N Na2 Players Of Null-A
Van Vogt; A.E. C+ 1982 Y N Ptath
Van Vogt; A.E. B+ 1982 Y N Quest For The Future
Van Vogt; A.E. B+ 1981 Y C N Renaissance
Van Vogt; A.E. C+ 1981 Y N Rogue Ship
Van Vogt; A.E. D+ 1981 N Secret Galactics
Van Vogt; A.E. C- 1981 N Silkie; The
Van Vogt; A.E. B 1998 Y N Slan 2 78/A+
Van Vogt; A.E. Y C N Supermind
Van Vogt; A.E. B- 1984 Y C N Twisted Men F253
Van Vogt; A.E. B 1980 Y N Universe Maker
Van Vogt; A.E. D- 1983 N Violent Man
Van Vogt; A.E. A 1981 Y C N Sb2 Voyage Of Space Beagle
Van Vogt; A.E. C+ 1981 Y N War Against The Rull
Van Vogt; A.E. A 1981 Y N Ws1 Weapon Makers
Van Vogt; A.E. A 1980 Y N Ws2 Weapon Shops Of Isher
Van Vogt; A.E. A 1980 Y N Winged Man
Van Vogt; A.E. B 1982 Y N L2 Wizard Of Linn
Van Vogt; A.E. A- 1981 Y N Na1 World Of Null-A
Vardeman; Robert E F 1989 N Cenotaph Road
Varley; John B- 1991 N Titan
Vidal; Gore D 1984 N Messiah
Vinge; Vernor B- 1986 Y C N Grimms World 2
Vinge; Vernor A 1988 Y N B2 Marooned In Realtime
Vinge; Vernor N B1 Peace War
Vinge; Vernor N True Names
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Vinge; Vernor N Witling
Vonnegut; Kurt Jr D 1983 N Player Piano
Wallace; Ian C- 1983 N Sign Of The Mute Medusa
Watkins; William Jon C 1978 N Clickwistle
Watkins; William Jon C- 1985 N What Rough Beast
Watson; Ian D 1977 N The Embeding
Weinbaum; Stanley G A 1981 Y SS Best Of
Wells; H.G. 1975 Y N War Of Worlds
West; Wallace C+ 1984 N Bird Of Time
White; James B+ 2007 Y C SS Aliens Among Us 2 84B+
White; James C+ 1983 N All Judgement Fled
White; James B+ 1983 Y C SN Sg4 Ambulance Ship
White; James A 1989 Y C N Sg7 Code Blue Emergency Buy ?
White; James B 1985 SN Deadly Litter
White; James C- 1986 N Dream Millenium 2
White; James B- 1984 Y N Escape Orbit
White; James B+ 1991 Y N Federation World
White; James B+ 1986 SS Futures Past
White; James B+ 2005 Y SN Sg1 Hospital Station 2 83A/05B+
White; James A+ 2004 Y N Lifeboat 2 83A/04A+
White; James B+ 2006 Y C SN Sg3 Major Operation 2 83B+/05B+
White; James B+ 1984 SS Monsters & Medics
White; James B 1991 Y N Open Prison
White; James C+ 1984 Y N Second Ending F173
White; James B+ 1984 Y C N Sg5 Sector General
White; James B+ 1985 Y C N Sg6 Star Healer
White; James B 2005 Y C N Sg2 Star Surgeon 2 83B+/85B
White; James B+ 2003 Y N Tomorrow Is To Far 2 84/A-
White; James C 1983 N Watch Below
White; Ted B- 1987 Y N Ap1 By Furies Possesed Arapad Novel
White; Ted A- N Forbidden World > Bischoff
White; Ted C 1988 N Pp1 Phoenix Prime
White; Ted B 1987 Y C N Secret Of Marauder Sat. Juvenille
White; Ted N Pp2 Star Wolf Don't Read
Wibberley; Leonard B+ 1976 N Beware Of The Mouse  Not Sf
Wibberley; Leonard B+ 1977 N Mouse On The Moon  Not Sf
Wibberley; Leonard B 1978 N Mouse On Wall Street  Not Sf
Wibberley; Leonard B+ 1976 N Mouse That Roared  Not Sf
Wilhelm; Kate F 1982 N Fault Lines  Not Sf
Wilhelm; Kate F+ 1982 N Juniper Time
Wilhelm; Kate D 1994 N Killer Thing 2 2x 75 B
Wilhelm; Kate A+ 1979 Y N Where Late Sweet Birds Sang
Williams; Paul O C- 1985 N P5 Ambush Of Shadows
Williams; Paul O B+ 2003 Y N P1 Breaking Of Northwall 2 85/B+
Williams; Paul O B+ 2003 Y C N P3 Dome In The Forest 2 85/A-
Williams; Paul O C 2003 Y C N P2 Ends Of The Circle 2 85/B-
Williams; Paul O C+ 2003 Y C N P4 Fall Of The Shell 2 85/B
Williams; Paul O B- 1985 N P6 Song Of The Axe
Williams; Robert M C- 1983 Y N Darkness Before Tomorrow F141
Williamson; Jack C 1982 Y C N Bright New Universe
Williamson; Jack A 1981 Y N Darker Than You Think
Williamson; Jack A- 1980 Y N Dragons Island
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Williamson; Jack C- 1982 N H2 Humanoid Touch
Williamson; Jack A- 1980 Y N H1 Humanoids
Williamson; Jack 1975 Y N L1 Legion Of Space
Williamson; Jack D 1982 N Lt1 Legion Of Time Old; 1938
Williamson; Jack 1979 Y C N Moon Children
Williamson; Jack N Not Men > Dragons Island
Williamson; Jack N Nowhere Near > One Against Legion
Williamson; Jack C 1980 Y N L5 One Against Legion
Williamson; Jack C 1988 SS Pandora Effect
Williamson; Jack B- 1977 N Power Of Blackness
Williamson; Jack B- N Reefs Of Space > Pohl
Williamson; Jack C- N Rogue Star > Pohl
Williamson; Jack 1975 Y ? N Seetee Ship; Seetee Shock
Williamson; Jack C- N Star Child > Pohl
Williamson; Jack 1978 Y C N Starbridge
Williamson; Jack C 1984 Y C N Trial Of Terra
Williamson; Jack B- N Undersea Quest > Pohl
Willis; Connie A- N Water Witch > Felice
Wilson; Colin Life Force > Space Vampires
Wilson; Colin N Mind Parasites
Wilson; Colin B 1977 N Space Vampires
Wollheim; Donald A Y C SS End Of The World
Wollheim; Donald A B 1987 Y SS Men On The Moon D277
Wollheim; Donald A B- 1995 Y ? N Secret Of Saturns Rings 2 75/B
Wollheim; Donald A C 1987 N Secret Of The 9th Planet Old
Woodcot; Keith B+ 1994 Y N I Speak For Earth 2 D497     76/B+
Woodcot; Keith B 1983 Y C N Ladder In The Sky F141
Woodcot; Keith B 1984 Y N Psionic Menace F199
Wright; Lan B- 1984 Y N Man Called Destiny D311
Wright; Susan B 2006 N Badlands  1 of 2 Star Trek book
Wright; Susan B- 2006 N Badlands  2 of 2 Star Trek book
Yates; W.R. C- 1988 N Diasporah
Zahn; Timothy B+ 1991 N SW7 Heir To The Empier Does not completely end
Zelazny; Roger A- 1986 Y C N Coils W/ Saberhagen
Zelazny; Roger B- 1986 Y N Doorways In The Sand
Zelazny; Roger F 1982 N Dream Master
Zelazny; Roger C- 1978 N Isle Of The Dead
Zelazny; Roger C+ 1987 N My Name Is Legion
Zelazny; Roger D+ 1986 N A1? Nine Princes In Amber
Zelazny; Roger B 1982 Y C N Roadmarks
Zelazny; Roger C- 1986 N This Immortal
Zetford; Tully D+ 1979 Y C N Hk2 Boosted Man
Zetford; Tully C+ 1980 Y C N Hk3 Star City
Zetford; Tully C+ 1980 Y C N Hk4 Virility Gene
Zetford; Tully C 1980 Y C N Hk1 Whirlpool Of Stars
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